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Lab 1
Installing VMware vSphere GUIs :

Objective: Install student desktop components

1. Access Your Student Desktop System

2. Install the vSphere Client

Task 1: Access Your Student Desktop System

You must access your student desktop system as Administrator.

Use the following information from the class configuration handout:

• Student desktop password 

1. Ask your instructor how to access your student desktop system.

For example, your instructor might ask you to use Remote Desktop Connection.

2. Log in to your student desktop system as Administrator, with the student desktop password.
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Task 2: Install the vSphere Client

VMware vSphere® Client™ is a Windows program that you can use to configure the host and 
operate its virtual machines.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• Location of the installation software

• Setup language

• Your VMware ESXi™ host name

• ESXi host user name

• ESXi host root password

1. Go to the location of the installation software.

2. Double-click autorun.exe and click Run. 

3. If Security Warning dialog boxes appear, click Run to continue.

4. In the VMware vCenter Installer window, click VMware vSphere Client.

5. Click Install to start the installation wizard. 

6. If Security Warning dialog boxes appear, click Run to continue.

7. When prompted by the install wizard, perform the following actions.

 

8. When the installation is complete, click Finish.

9. Click Exit to close the VMware vCenter Installer window.

Option Action

Setup Language Select the setup language and click OK.

Welcome page Click Next.

License Agreement Select I agree to the terms in the license 
agreement and click Next.

Destination Folder Accept the default and click Next.

Ready to Install the Program Click Install.
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10. Log in to your ESXi host with the vSphere Client.

a. Double-click the vSphere Client icon on your student desktop system. 

b. Read all the text on the vSphere Client login window.

c. Type the IP address or host name of your ESXi host in the IP Address/Name text box.

d. Type the user name root and the ESXi host root password.

e. Click Login. 

f. Select Install this certificate and do not display security warnings for “<host_name>” 
to prevent this warning from being displayed in the future.

g. Click Ignore to proceed with the connection.

h. Click OK when the VMware Evaluation Notice dialog box is displayed.

11. In the navigation bar at the top of the vSphere Client, verify that Home > Inventory > 
Inventory is displayed.

12. Verify that your host is listed as the root in the Inventory view on the left side of the window.

13. In the vSphere Client menu bar, select File > Exit to close the vSphere Client.
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Lab 2
Configuring VMware ESXi :

Objective: Configure an ESXi host

In this lab, you will perform the following tasks:

1. Connect to an ESXi Host with the vSphere Client

2. View the Host Hardware Configuration

3. Configure the DNS and Routing Information for an ESXi Host

4. Configure an ESXi Host as an NTP Client

5. Configure an ESXi Host to Use Directory Services

Task 1: Connect to an ESXi Host with the vSphere Client

Use the VMware vSphere® Client™ to log in to a VMware ESXi™ host.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• Your ESXi host name

• ESXi host root password

1. Log in to the system you used earlier.

The instructor provides you with login procedures for your specific lab environment.
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2. Double-click the vSphere Client icon on the system’s desktop.

3. Type the host name of your ESXi host.

4. Type the user name root and the ESXi host root password.

5. Click Login. 

6. If a certificate warning is displayed, click Ignore.

7. In the VMware Evaluation Notice window that states when your evaluation license expires, 
click OK.

Your host must be displayed in the inventory panel. 

8. If your host is not displayed, click Home and click the Inventory icon in the menu bar.

Task 2: View the Host Hardware Configuration

View the health of the host hardware, as well as processor and memory information. 

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• Your ESXi host name

• ESXi host root password

1. Select your ESXi host in the inventory and click the Configuration tab.

The hardware health status view is displayed. 

2. View the status by expanding objects in the Sensor list.

3. In the Hardware list, click Processors. 

4. View the processor model, processor speed, and other information about your ESXi host 
processors.

5. In the Hardware list, select Memory. 

6. View the total physical memory, the memory used by the system, and the memory available for 
use by the virtual machines.
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Task 3: Configure the DNS and Routing Information for an ESXi Host

Verify the DNS and routing information for your ESXi host. 

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• Preferred DNS server

• VMkernel default gateway

• Domain name

1. Select your ESXi host in the inventory and click the Configuration tab.

2. In the Software panel, click the DNS and Routing link.

3. Click the Properties link. 

4. In the DNS Configuration panel, perform the following actions.

5. Click OK to close the DNS and Routing Configuration dialog box.

6. If you receive an IPv6 warning, click Yes to continue.

Option Action

Domain Verify that the AD domain name matches the value in the class 
configuration handout.

If the domain name does not match, type the domain name.

Use the following DNS 
server address

If this text box is populated, verify that the setting matches the 
preferred DNS server in the class configuration handout.

If this text box is blank or incorrect, type the preferred DNS server.

Look for hosts in the 
following domains

Leave the default.

Default Gateway Click the Routing tab.

Verify that the IP address is for the VMkernel default gateway in the 
class configuration handout.

If the default gateway is not defined or is incorrect, type the IP 
address for the VMkernel default gateway.
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Task 4: Configure an ESXi Host as an NTP Client

System time is important for many computer applications.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• Network Time Protocol (NTP) server

1. Select your ESXi host in the inventory and click the Configuration tab.

2. In the Software panel, click Time Configuration. 

3. View the current settings, which show that the NTP client is stopped and that no NTP server is 
defined.

4. Click Properties.

5. In the Time Configuration dialog box, perform the following actions.

6. Click OK to exit the Time Configuration dialog box.

7. Verify that the Time Configuration pane lists the NTP server that you added and that the NTP 
Client is listed as Running.

NOTE

If the status of the NTP Client has not changed to Running, go back to the Properties dialog box 
and click Options. In the General panel, click Start to start the NTP service.

Option Action

Date and Time Record the date and time. __________

NTP Configuration Select the NTP Client Enabled check box and click Options. 

General Select the Start and stop with host check box and click NTP Settings.

NTP Settings In the NTP Daemon Options dialog box, click Add. 

Type the NTP server name or IP address from the class configuration 
handout. 

Click OK to close the Add NTP Server window.

Select the Restart NTP service to apply changes check box and click 
OK.
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Task 5: Configure an ESXi Host to Use Directory Services

The ESXi host can be configured to use a directory service, such as Active Directory (AD) to 
manage users.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• Domain administrator user name 

• Domain administrator password 

• Domain name

1. Select your ESXi host in the inventory and click the Configuration tab.

2. Under Software, click the Authentication Services link. 

3. Click the Properties link. 

4. In the Directory Services Configuration dialog box, perform the following actions.

5. Click OK to close the Directory Services Configuration dialog box.

6. Verify the entries in Authentication Services Settings.

7. Leave the vSphere Client open for the next lab.

Option Action

User Directory Service Select Active Directory.

Domain Settings Type the domain name from the class configuration handout and 
click Join Domain.

Join Domain Type your domain administrator user name (without the domain 
name) and the domain administrator password. Leave the 
vSphere Authentication Proxy check box deselected.

Click Join Domain. 
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Lab 3
Working with Virtual Machines :

Objective: Create and prepare virtual machines for use

In this lab, you will perform the following tasks:

1. Create a Virtual Machine

2. Install a Guest Operating System in a Virtual Machine

3. Identify a Virtual Machine Disk Format and Usage Statistics

4. Install Tools on a Virtual Machine Installed with a Windows OS

5. Prepare Your Virtual Machine for Upcoming Labs

Task 1: Create a Virtual Machine

You can create a single virtual machine if no other virtual machines in your environment have the 
requirements you are looking for, such as a particular operating system or hardware configuration.

Both students should perform this task.

Use the following information from the class configuration handout:

• Your VMware ESXi™ host name

• ESXi host root password

• Virtual machine datastore

• Guest operating system version

• ISO images location

• Guest installation ISO
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1. If the VMware vSphere® Client™ is not already active, log in to your ESXi host by typing the 
user name root and the ESXi host root password.

2. In the navigation bar of the vSphere Client, click Home and click the Inventory icon.

3. Right-click your ESXi host in the inventory and select New Virtual Machine. 

4. When prompted by the Create New Virtual Machine wizard, perform the following actions.

Option Action

Configuration Click Custom and click Next.

Name (of virtual machine) Name the new virtual machine with your first name, followed 
by the number of your ESXi host and a sequence number, 
starting with 1. For example, Mike has an ESXi host named 
goose06. The name of his virtual machine is Mike06-1.

Click Next.

Datastore Select the name of the virtual machine datastore and click 
Next.

Virtual Machine Version Keep the default and click Next.

Guest Operating System Select the guest operating system and click Next.

Number of virtual processors Keep the default and click Next.

Memory To ensure that you are configuring 384MB of memory (not 
GB), select MB from the drop-down menu and type 384 in 
the space provided. Click Next.

How many NICs do you want 
to connect

Keep the default value of 1.

NIC 1 Network Keep the default.

NIC 1 Adapter Keep the default.

Connect at Power On Leave selected and click Next.

SCSI Controller Keep the default and click Next.

Disk Keep the default and click Next.
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5. In the Hardware list, click New CD/DVD (adding).

6. Click Datastore ISO file.

7. Click Browse and go to the ISO images location.

8. Click Open.

9. Select the guest installation ISO image and click OK.

10. In the Virtual Machine Properties dialog box, select the Connect at power on check box.

11. Click Finish to save the changes. 

12. Expand the inventory and verify that the new virtual machine is displayed in the inventory 
panel.

13. In the inventory panel, select the virtual machine that you created. 

14. Click the Summary tab and record the following information.

• Provisioned Storage __________

• Not Shared Storage __________

• Used Storage __________

Disk Size Type 2GB.

Disk Provisioning Click Thin Provision.

Location Keep the default (store with the virtual machine) and click 
Next.

Virtual Device Node Keep the default.

Mode – Independent Leave deselected and click Next.

Ready to Complete Select the Edit the virtual machine settings before 
completion check box and click Continue. The Virtual 
Machine Properties dialog box is displayed.

Option Action
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Task 2: Install a Guest Operating System in a Virtual Machine

After a new virtual machine is created, an unattended installation of a Windows guest operating 
system is performed.

Students should do the steps in this task individually.

1. On the Summary tab, click Power On in the Commands panel.

2. Click the Open Console link and monitor installation progress.

The Windows guest operating system should perform an unattended installation. After your 
virtual machine powers on, it begins to install the guest operating system. The installation might 
take up to 25 minutes.

3. After the installation is complete, click Connect/disconnect the CD/DVD devices of the 
virtual machine (the right-most active icon) in the icon bar of the virtual machine console 
window.

4. Select CD/DVD Drive 1 > Disconnect from datastore image. 

5. Click Yes to disconnect the device.

6. Leave the virtual machine console open.

Task 3: Identify a Virtual Machine Disk Format and Usage Statistics

Identify the virtual machine disk (VMDK) type.

Students should do the steps in this task individually.

1. Right-click the your_name##-1 virtual machine in the inventory and select Edit Settings.

2. In the Hardware list, select Hard disk 1. 

3. Under Disk Provisioning, identify the VMDK type. 

Q1. What type of VMDK has been provisioned?

1. The disk type should read Thin Provision.

4. Click Cancel to close the Virtual Machines Properties dialog box.

5. Click the your_name##-1 virtual machine and click the Summary tab.

6. In the Resources panel, click the Refresh Storage Usage link to update the Provisioned 
Storage and Used Storage metrics. 

7. Record the updated information.

• Provisioned Storage __________

• Not Shared Storage __________

• Used Storage __________
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8. Compare these values to the values listed in task 1, step 14. 

The values should be different. Although a 2GB virtual VMDK has been configured for this 
virtual machine, the storage space consumed by the VMDK is lower than the total allocated 
disk space. The used storage space increases dynamically as the virtual machine is used.

Task 4: Install Tools on a Virtual Machine Installed with a Windows OS

VMware® Tools™ is a suite of utilities that enhances the performance of the virtual machine’s 
guest operating system and improves management of the virtual machine.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• Virtual machine administrator password

1. From the virtual machine console, log in to the guest operating system.

a. In the menu bar of the virtual machine console, select VM > Guest > Send Ctrl+Alt+Del.

b. In the Windows login screen, log in as user Administrator with the virtual machine 
administrator password.

2. Install VMware Tools into the Windows guest operating system.

a. In the menu bar of the virtual machine console, select VM > Guest > Install/Upgrade 
VMware Tools. 

NOTE

If you are unable to move the pointer to the menu bar, press Ctrl+Alt to release the pointer 
from the virtual machine console. 

b. Read the warning message that is displayed and click OK.

c. Click anywhere in the virtual machine console window to select your virtual machine.

d. The VMware Tools installation wizard starts. 

e. On the welcome page, click Next.

f. On the Setup Type page, leave Typical selected and click Next.

g. Click Install to start the installation. 

Over the span of several seconds, several windows are displayed.
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3. If you see a pop-up window informing you that hardware acceleration is not enabled, click Yes.

a. In the Display Properties dialog box, click the Settings tab and click the Advanced button.

You might have to move the VMware Tools Installation wizard to the side so that you can 
see the Display Properties dialog box. 

b. Click the Troubleshoot tab. 

c. Drag the Hardware Acceleration bar from None to Full. 

d. Click OK.

e. Click OK to exit the Display Properties dialog box.

If you do not see a pop-up window, hardware acceleration is already enabled. 

4. Click Finish to exit the VMware Tools Installation wizard.

5. When prompted to restart the virtual machine, click Yes.

6. After the virtual machine finishes rebooting, log in as user Administrator.

7. Leave the virtual machine console open.

Task 5: Prepare Your Virtual Machine for Upcoming Labs

To prepare for later labs, you mount the ClassFiles-vSphere.iso image file and copy 
programs to your virtual machine’s desktop. This ISO image contains files needed for future labs. 
You must also turn off automatic updates to prevent your virtual disk from filling up with 
unnecessary files.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• ISO images location

1. Connect ClassFiles-vSphere.iso to your virtual machine’s CD-ROM drive.

a. In the icon bar of the virtual machine console window, click the Connect/disconnect the 
CD/DVD devices of the virtual machine icon (the right-most active icon).

b. Select CD/DVD Drive 1 > Connect to ISO image on a datastore.

c. In the Look in drop-down menu, select Datastores.

d. Select the ISO images location.

e. Select Classfiles-vSphere.iso and click OK.

2. If autorun does not open the CD-ROM, use Windows Explorer and go to the CD-ROM drive 
(D:).
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3. Copy cpubusy.vbs and iometer.exe from the CD-ROM drive (D:) to the virtual machine’s 
desktop to be used in a later lab.

a. Right-click the file on the CD-ROM and select Copy.

b. Right-click the desktop and select Paste.

4. Extract the files to be used in a later lab from the executable extpart.exe.

a. On the CD-ROM, double-click the extpart.exe file.

b. In the WinZip Self-Extractor dialog box, click Unzip. 

Two files are unzipped to the path C:\dell\ExtPart. 

c. Click OK.

d. Click Close to close the WinZip Self-Extractor dialog box.

5. Disconnect from Classfiles-vSphere.iso on the CD-ROM drive.

a. Right-click the virtual machine in the inventory and select Edit Settings.

b. In the Hardware list, select CD/DVD Drive 1.

c. Deselect the Connected check box. 

d. Click OK.

6. Turn off automatic updates in your Windows guest operating system.

NOTE

The following steps apply to the Windows 2003 operating system. These steps help prevent the 
virtual machine’s disk from filling up with unnecessary files. A virtual machine with 
insufficient disk space can affect future lab exercises.

a. From the virtual machine’s desktop, select Start > Settings > Control Panel.

b. Double-click System.

c. Click the Automatic Updates tab.

d. Select Turn Off Automatic Updates and click OK.

e. Close the virtual machine console.

7. Select File > Exit to log out of your vSphere Client session.
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Lab 4
Configuring VMware vCenter Server 
Appliance :

Objective: Configure vCenter Server Appliance for first 
use

In this lab, you will perform the following tasks:

1. Configure vCenter Server Appliance for First Use

2. Install vSphere License Keys

3. Create a vCenter Server Inventory Data Center Object

4. Add Your ESXi Host to the vCenter Server Inventory

Task 1: Configure vCenter Server Appliance for First Use

The VMware® vCenter™ Server Appliance™ is a preconfigured Linux-based virtual machine that 
is optimized for running VMware® vCenter Server™ and associated services. vCenter Server 
Appliance must be configured before first use.

NOTE

The Google Chrome Web browser is recommended for all Web-based labs in this course.

Students should do the steps in this task as a team from a single student desktop.
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Use the following information from the class configuration handout:

• vCenter Server Appliance name

• vCenter Server root password

• Preferred DNS server

1. Open a Web browser and connect to the vCenter Server Appliance management page at https://
vCenter_Server_Appliance_name:5480/.

2. If you get a warning that the site security certificate is not trusted, proceed anyway to the 
administration page.

3. On the vCenter Server Setup page, click Accept license Agreement and click Next.

4. On the Configure Options page, click Configure with default settings and click Next.

5. On the Review configuration page, click Start.

NOTE

This step might take several minutes to complete.

6. After the setup is complete, click Close.

7. Click the Network tab.

8. Click the Address button.

9. Verify that the Preferred DNS server matches the value in the class configuration handout. 

10. If the value is blank, type the Preferred DNS server and click Save Settings.

Task 2: Install vSphere License Keys

License keys unlock advanced features of VMware vSphere® 5.5. 

Students should do the steps in this task as a team from a single student desktop

Use the following information from the class configuration handout:

• vCenter Server Appliance name

• vCenter Server root password

• vCenter Server license key

1. Browse to the VMware vSphere® Web Client and log in to your vCenter Server Appliance at 
https://vCenter_Server_Appliance_name:9443/vsphere-client/.

2. On the vCenter Server Appliance Login page, log in as root with the vCenter Server root 
password and click Login.
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3. On the home page, select Administration > Licensing > Licenses.

The Licensing pane is displayed.

4. Click vCenter Server Systems.

5. Click Assign License Key at the upper-left corner of the pane.

6. From the Assign an existing license key drop-down menu, select Assign a new license key.

The Assign License Key dialog box is displayed.

7. Type the following information in the Assign License Key dialog box.

8. Click OK.

Option Action

Enter License Keys In License key, type the vCenter Server license key. 

NOTE

Include the hyphens: XXXXX-XXXXX-XXXXX-XXXXX-XXXXX. 
(The text box forces you to type a hyphen every five characters.)

In Label, type VMware Training Licenses. Click Decode.
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Task 3: Create a vCenter Server Inventory Data Center Object

A virtual data center is a container for all the inventory objects required to complete a fully 
functional environment for operating virtual machines.

Students should do the steps in this task as a team from a single student desktop.

1. Select Home > vCenter > Hosts and Clusters.

2. In the Getting Started tab, click the Create Datacenter icon.

3. In the data center name text box, type Training.

4. Click OK.

Task 4: Add Your ESXi Host to the vCenter Server Inventory

To create a vSphere virtual environment and use vSphere features, add VMware ESXi™ hosts to the 
vCenter Server inventory.

Students should do the steps in this task individually. Student 2 should log in to the vCenter Server 
Appliance with the vSphere Web Client for this lab exercise.

Use the following information from the class configuration handout:

• Your ESXi host name

• ESXi host root password

• VMware vSphere® Enterprise Plus Edition™ license key

1. On the home page, select Home > vCenter > Hosts and Clusters.

2. In the navigation panel, right-click Training and click Add Host.
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3. Type the following information in the Add Host wizard.

4. In the Recent Tasks pane at the right of the vSphere Web Client, monitor the progress of the 
task. 

5. Expand the Training object and select your ESXi host.

6. Click the Summary tab and view the information about the ESXi host, such as its datastores, 
networks, number of NICs and CPUs, and memory usage.

7. Log out of the vSphere Web Client.

Option Action

Host Type the fully qualified domain name of your ESXi host and 
click Next.

Username Type root.

Password Type the ESXi host root password and click Next. 

A security alert is displayed, stating that vCenter Server is unable 
to verify the authenticity of the specified host. Click Yes to 
proceed.

Host Summary Verify the information and click Next.

Assign License From the Assign an existing license key drop-down menu, select 
Assign a new license key. 

In the License Key box, type the vSphere Enterprise Plus Edition 
license key. 

Click Decode. 

Ignore license warnings that might be displayed and click Next.

Lockdown Mode Do not enable lockdown mode. Click Next.

Virtual Machine Location Select the data center and click Next.

Ready to Complete Review the configuration summary and click Finish.
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Lab 5
Using the VMware vSphere Web Client :

Objective: Demonstrate the ability to navigate and 
customize the vSphere Web Client

In this lab, you will perform the following tasks:

1. Install the Client Integration Plug-In

2. Navigate the vSphere Web Client

3. Pin and Unpin Panes

4. Hide the Getting Started Tabs

5. Upgrade Virtual Machine Hardware

Task 1: Install the Client Integration Plug-In

The Client Integration plug-in provides access to a virtual machine’s console in the VMware 
vSphere® Web Client, and provides access to other VMware vSphere® infrastructure features.

Students should do the steps in this task individually.

1. Open a Web browser and connect to the VMware® vCenter™ Server Appliance™ management 
page at https://vCenter_Server_Virtual_Appliance:9443/.

2. Click the Download the Client Integration Plug-in link at the bottom of the vSphere Web 
Client login page.
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3. Click the file in the download bar to run the installation program and wait for the security 
warning to appear.

4. Close the Web browser.

5. In the Open File - Security Warning dialog box, click Run.

6. On the Welcome page, click Next.

7. Select I accept the terms in the License Agreement and click Next.

8. Accept the default destination folder and click Next.

9. Click Install.

10. After the installation completes, click Finish.

Task 2: Navigate the vSphere Web Client

The vSphere Web Client displays perspectives and actions for objects in the navigator in a consistent 
manner.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• VMware® vCenter Server™ root password

• Local datastore name

1. Open a Web browser and connect to the vCenter Server Appliance management page at https://
vCenter_Server_Virtual_Appliance:9443/.

2. On the vSphere Web Client login page, log in as root and type the vCenter Server root 
password.

3. Click Login.

4. Select vCenter > Hosts and Clusters.

5. Expand the data center object and double-click your host.
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6. Navigate to the top-level object by clicking the quick navigation menu in the content area.

7. Click vcva01 to return to the top of the navigation tree.

8. In the Search dialog box, type the name of your local datastore and press Enter. 

Information about the local datastore is displayed.

9. Click the Summary tab of the datastore to view the datastore details.

10. Use the Home icon to return to the vSphere Web Client Home page.

Task 3: Pin and Unpin Panes

The vSphere Web Client panes can be adjusted to provide more space for the content area.

Students should do the steps in this task individually.

1. Select vCenter > Hosts and Clusters.

2. Expand the data center object and double-click your host.

3. In the navigator pane, click the pin icon.

4. Click in the content pane. 

5. Record what happens to the navigator pane. __________

6. Click in the navigator pane. 

7. Record what happens to the navigator pane. __________

8. Click the pin icon in the navigator pane to re-pin the window.
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9. In the Alarms window, click the Maximize icon to maximize the Alarms window.

10. To restore the Alarms window, click the Restore Down icon in the Alarms pane.

Task 4: Hide the Getting Started Tabs

Most inventory objects have Getting Started tabs. These tabs can be hidden.

Students should do the steps in this task individually.

1. In the vSphere Web Client, click the Home icon.

2. From the Help drop-down menu, above the content pane, select Hide All Getting Started 
Pages.

3. Select Home > vCenter > Hosts and Clusters.

4. Expand the data center object and select your host. 

5. Record the first tab you see in the content pane. __________

6. Click the Home icon to return to the home page.

7. From the Help drop-down menu, select Show All Getting Started Pages.
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Task 5: Upgrade Virtual Machine Hardware

The latest version of the virtual machine hardware is only available through the vSphere Web Client.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• Your VMware ESXi™ host name

1. Select Home > vCenter > Hosts and Clusters > Training.

2. Expand your ESXi host to display your virtual machine.

3. Right-click the yourname##-1 virtual machine and click Shutdown Guest OS.

4. Click Yes to confirm the shutdown.

5. When the virtual machine is shut down, click the yourname##-1 virtual machine Summary tab.

6. Locate the Compatibility value for the virtual machine and record the hardware version that is 
displayed. __________

7. Right-click the yourname##-1 and click Edit Settings.

8. Click the arrow next to Upgrade to expand the upgrade properties.

9. Select Schedule VM Compatibility Upgrade.

10. Ensure that Compatible with reads ESXi 5.5 and later.

11. Click OK.

12. Right-click the yourname##-1 virtual machine and click Power on.

13. Click the yourname##-1 virtual machine Summary tab.

14. Under the virtual machine name at the top of the tab, verify that Compatibility reads ESX 5.5 
and later as shown in the graphic.

15. Log out of the vSphere Web Client.
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Lab 6
Configuring VMware vCenter Single 
Sign-On :

Objective: Configure an identity source for vCenter 
Single Sign-On

In this lab, you will perform the following tasks:

1. Use the Web Console to Configure vCenter Server Appliance to Use Directory Services

2. Use the vSphere Web Client to Add the Domain Admins Group to Administrators

Task 1: Use the Web Console to Configure vCenter Server Appliance 
to Use Directory Services

Configure the VMware® vCenter™ Server Appliance™ device to use directory services.

Students should do the steps in this task as a team from a single student desktop.

Use the following information from the class configuration handout:

• vCenter Server Appliance name

• vCenter Server Appliance root password

• Windows Domain administrator user name

• Windows Domain administrator password

• Windows domain
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1. On the desktop of the Desktop system, open a Web browser and go to https://
vCenter_Server_Appliance_name:5480 to open the vCenter Server Appliance management 
interface.

2. Log in to your vCenter Server Appliance with the root user name and password.

3. On the vCenter Server tab, click Authentication.

4. On the Authentication page, select the Active Directory Enabled check box.

5. In the Domain text box, type the Windows domain name.

6. In the user and password text boxes, type the Windows Domain administrator user name and 
password.

7. Click Save Settings.

8. At the top of the Google Chrome browser, click the System tab.

9. Click Reboot.

10. On the System Reboot confirmation page, click Reboot.

NOTE

The appliance takes several minutes to reboot. The System Reboot dialog box closes after the 
reboot is near completion.

11. Log in to the vCenter Server Appliance administration page, https://
vCenter_Server_Appliance_name:5480 with the user name and password.

12. On the Summary page, in the Services window, monitor the services listed until four of the 
five services are listed as Running.

NOTE

The VMware vSphere® Auto Deploy™ service is not started in this lab.

13. Click Logout user root.

14. Leave the browser open for the next task.

Task 2: Use the vSphere Web Client to Add the Domain Admins Group 
to Administrators

Allow the ESX Admins group to log in to VMware® vCenter Server™ as administrators.

Students should do the steps in this task as a team from a single student desktop.

Use the following information from the class configuration handout:

• Windows domain
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• vCenter Server Appliance single sign-on (SSO) administrator user name

• vCenter Server Appliance SSO administrator password

• Base DN for users

• Base DN for groups

• Fully qualified domain name (FQDN)

• Windows domain administrator user name

• Windows domain administrator password

• Primary server URL

1. In the browser, go to https://vCenter_Server_Appliance_name:9443/vsphere-client/.

2. Log in to your vCenter Server Appliance with the vCenter Server Appliance SSO administrator 
user name and password.

3. In the navigation bar on the left, click Administration.

4. Under Single Sign-On, select Configuration.

5. Click the Identity Sources tab.

6. Click the Add Identity Source (green plus sign) icon.

7. In the Add identity source dialog box, add the following information.

Option Action

Identity source type Select Active Directory as a LDAP Server.

Name Type the Windows domain name.

Base DN for users Type the Base DN for users.

Domain Name Type the FQDN.

Domain alias Type the Windows domain name.

Base DN for groups Type the Base DN for groups.

Primary server URL Type the primary server URL.

User name Type the domain administrator user name.

Password Type the domain administrator password.
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8. Click Test Connection.

A dialog box appears indicating that the connection has been established.

9. Click OK.

10. Click OK to close the Add identity source dialog box.

11. In the left pane under Single-Sign-On, select Users and Groups.

12. Click the Groups tab.

13. Click Administrators under Group Name.

14. In the bottom Group Members pane, click the Add member (blue person with green plus sign) 
icon.

15. Select the Windows domain specified in the class configuration handout. 

16. Select ESX Admins and click Add.

17. Click OK.

18. Log out of the VMware vSphere® Web Client.

19. Log in to the vSphere Web Client using the Windows domain administrator user name and 
password.

20. Select vCenter > Hosts and Clusters. 

Q1. Do you see your host in the inventory?

1. You do not see any hosts in the inventory. Although you have permission to log in to the 
server, you have not given permissions to the VMware ESXi™ administrators to see any of the 
vCenter Server objects in the inventory.

21. Log out of the vSphere Web Client.
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Lab 7
Creating Folders in VMware vCenter 
Server :

Objective: Create vCenter Server inventory objects

In this lab, you will perform the following tasks:

1. Create a Host Folder Object

2. Create Two Virtual Machine Folders

Task 1: Create a Host Folder Object

You can use folders to group objects of the same type for easier management. 

Students should do the steps in this task as a team from a single student desktop.

Use the following information from the class configuration handout:

VMware® vCenter™ Server Appliance™ root password

1. If the VMware vSphere® Web Client is not already active, open a Web browser and connect to 
the vCenter Server Appliance page at https://vCenter_Server_Virtual_Appliance:9443/.

2. On the vCenter Server Appliance Login page, log in as root and type the administrator 
password.

3. Click Login.

4. Select vCenter > Hosts and Clusters.

5. Right-click the Training data center and click All vCenter Action.

6. Click New Host and Cluster Folder.
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7. Type Lab Servers for the folder name and click OK.

NOTE

It might be necessary to refresh the vSphere Web Client to see the new folder.

8. Drag both the VMware ESXi™ hosts into the Lab Servers folder.

Task 2: Create Two Virtual Machine Folders

Virtual machine folders help you to group virtual machines.

Students should do the steps in this task as a team from a single student desktop.

1. Select Home > vCenter > VMs and Templates.

2. Right-click the Training data center and click All vCenter Actions.

3. Click New VM and Templates Folder.

4. Type LabVMs for the folder name and click OK.

5. Drag all the virtual machines into the new folder.

6. To create a second virtual machine folder, right-click the Training data center and click All 
vCenter Actions.

7. Click New VM and Templates Folder.

8. Type Templates for the name of this second folder and click OK.

9. To view the created folders, double-click the Training data center object and click Top Level 
Objects. 

10. Right-click each of the three folders that you created. 

Q1. How do the menus differ between the Hosts and Clusters folder and the VMs 
and Templates folder?

1. The Lab Servers folder displays menu choices related to host actions whereas the LabVM 
and Templates folders display menu choices related to virtual machines.
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Lab 8
Standard Switches :

Objective: Create a standard switch and port group

In this lab, you will perform the following tasks:

1. View the Current Standard Switch Configuration

2. Create a Standard Switch with a Virtual Machine Port Group

3. Attach Your Virtual Machine to a New Virtual Machine Port Group

Task 1: View the Current Standard Switch Configuration

Use the VMware vSphere® Web Client to ensure the proper configuration of a VMware vSphere® 
standard switch.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• VMware® vCenter™ Server Appliance™ name

• VMware® vCenter Server™ root password

• Your VMware ESXi™ host name

1. If the vSphere Web Client is not already active, open a Web browser and connect to the vCenter 
Server Appliance home page at https://vCenter_Server_Virtual_appliance_name:9443/.

2. On the vCenter Server Appliance Login page, log in as root with the password and click Login.

3. Select vCenter > Hosts and Clusters > Lab Servers > Your_ESXi_host_name.
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4. Click Manage and select Networking.

5. Click Virtual Switches.

The virtual switch is named vSwitch0. vSwitch0 is connected to the physical adapter vmnic0. 
vSwitch0 contains a VMkernel port named Management Network and a virtual machine port 
group named VM Network. A virtual machine is connected to VM Network.

Task 2: Create a Standard Switch with a Virtual Machine Port Group 

Standard switches handle network traffic at the host level in a vSphere environment.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• vmnics to use for the Production virtual switch

1. Click the Add host networking icon (the first icon on the left).

2. When prompted by the Add Networking wizard, perform the following actions.

Option Action

Connection Type Select Virtual Machine Port Group for a Standard Switch 
and click Next.

Select target device Select New standard switch.

Click Next.

Create a Standard Switch Click the + icon under Assigned adapters.

Select the vmnics listed in the class configuration handout. 
Press the Ctrl key to select multiple adapters.

Click OK.

Click Next.



8

Lab 8 Standard Switches 39

3. Under Virtual Switches, click vSwitch1.

4. Verify that the Production port group is displayed in the Networking pane.

Task 3: Attach Your Virtual Machine to a New Virtual Machine Port 
Group

Virtual machine port groups provide networking for virtual machines.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• Virtual machine administrator password

1. Select Home > vCenter > VMs and Templates.

2. Click Training and then click Lab VMs.

3. Right-click your named virtual machine in the inventory and select Edit Settings.

4. To expand the network adapter properties, click the arrow next to Network Adapter 1.

5. From the Network Connection drop-down menu, select Production.

6. Verify that both the Connected and the Connect at power on check boxes are selected.

7. Click OK to close the Edit Settings window.

8. To verify that the virtual machine can access the Web, renew the virtual machine IP address.

a. Right-click the virtual machine in the vCenter Server inventory and select Open Console.

NOTE

Ensure that your Web browser is configured to allow pop-ups. In Google Chrome the pop-
up blocker can be configured in the address bar in the right corner.

b. Click the Send CTRL ALT Del button in the top-right corner of the virtual machine 
console.

c. Log in as Administrator and use the virtual machine administrator password. 

d. To open a Command Prompt window, select Start > Run.

Connection Settings In the Network label text box, type Production.

Keep the default setting for VLAN ID and click Next.

Ready to Complete Click Finish.

Option Action
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e. Type cmd. 

f. At the command prompt, type ipconfig /release and press Enter.

g. Type ipconfig /renew and press Enter.

9. In Internet Explorer, go to http://www.vmware.com.

10. Exit Internet Explorer.

11. Close the virtual machine’s console.

12. Leave the vSphere Web Client open for the next lab.
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Lab 9
Accessing iSCSI Storage :

Objective: Configure access to an iSCSI datastore

In this lab, you will perform the following tasks:

1. Add a VMkernel Port Group to a Standard Switch

2. Configure the iSCSI Software Adapter

Task 1: Add a VMkernel Port Group to a Standard Switch 

A VMkernel networking interface provides network connectivity for the host and handles VMware 
vSphere® vMotion®, IP storage, and VMware vSphere® Fault Tolerance.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• VMware® vCenter™ Server Appliance™ name

• vCenter Server root password

• VMkernel port IP address or subnet mask

• VMkernel default gateway

1. If the VMware vSphere® Web Client is not already active, open a Web browser and connect to 
the vCenter Server Appliance Login page at https://
vCenter_Server_Virtual_Appliance_name:9443/.

2. On the vCenter Server Appliance Login page, log in as root with the password and click Login.

3. Select Home > Hosts and Clusters > Training > Lab Servers > Your_ESXi_host_name.

4. Click Manage and click Networking.
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5. Click Virtual Switches and select vSwitch0 from the list of virtual switches.

6. Click the Add host networking icon (the left-most icon).

7. When the Add Network wizard starts, perform the following actions.

Task 2: Configure the iSCSI Software Adapter

With the software-based iSCSI implementation, you can use standard NICs to connect your host to a 
remote iSCSI target on the IP network. The software iSCSI adapter that is built into VMware 
ESXi™ enables this connection by communicating with the physical NICs through the network 
stack.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• Your ESXi iSCSI qualified name (IQN)

• Name of the iSCSI target

1. On the Manage tab, click Storage.

2. Click Storage Adapters.

3. Click the Add new storage adapter icon.

4. Select Software ISCSI adapter.

5. In the Add Software ISCSI Adapter dialog box, click OK.

Option Action

Connection Type Select VMkernel Network Adapter and click Next.

Select target device Ensure that Select an existing standard switch is selected and 
click Next.

Port properties Type IP Storage for the Network Label. 

Keep the default for all other settings and click Next.

IPv4 settings Select Use static IPv4 settings.

Type the VMkernel port IP address and subnet mask.

Verify that the VMkernel default gateway IP address is correct.

Click Next.

Ready to complete Click Finish.
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6. Select the newly created iSCSI software adapter.

7. On the Properties tab, in Adapter Details, verify that the Adapter Status reads Enabled.

8. On the Properties tab, in the General section under Adapter Details, click Edit.

9. Verify that the dialog box displays the iSCSI initiator name. 

If the IQN does not match your ESXi iSCSI IQN, change the IQN to match the value.

10. In the Adapter Details section, click the Network Port Binding tab.

11. Click the + icon.

12. Select the VMKernel adapter you created in task 1 and click OK.

13. Click OK.

14. In the Adapter Details section, click the Targets tab.

15. Ensure that Dynamic Discovery is selected and click Add.

16. Type the name or IP address of the iSCSI target.

17. Leave the port set to 3260 and click OK.

18. Monitor the Recent Tasks pane and wait for the task to complete.

19. Click the Rescan adapter icon (the third icon from the left), and click OK to rescan the 
adapters. 

Wait for the rescan task to complete. 

20. From the Storage Adapters list, select the iSCSI software adapter and view the Paths tab.

21. Record the following values to verify that a logical unit number (LUN) and multiple LUNs 
were found.

• Target __________

• Runtime names __________

• LUNs __________
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Lab 10
Accessing NFS Storage :

Objective: Configure access to an NFS datastore

In this lab, you will perform the following tasks:

1. Configure Access to NFS Datastores

2. View NFS Storage Information

Task 1: Configure Access to NFS Datastores

You can use the Add Storage wizard to mount an NFS volume and use it as a datastore.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• VMware® vCenter™ Server Appliance™ name

• VMware® vCenter Server™ root password

• NFS server host name

• Your NFS logical unit number

1. If the VMware vSphere® Web Client is not already active, open a Web browser and connect to 
the vCenter Server Appliance home page at https://
vCenter_Server_Virtual_Appliance_name:9443/.

2. On the Login page, log in as root with the password and click Login.

3. Select vCenter > Storage > Training.

4. Click Related Objects and select Datastores.
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5. In the Datastores pane, click the Create a new datastore icon.

6. When prompted by the New Datastore wizard, perform the following actions.

Task 2: View NFS Storage Information

You can view information about your NFS storage and the contents of the NFS datastore.

Students should do the steps in this task individually.

1. Expand the Training data center and select the NFS datastore you created in task 1.

2. Click the Monitor tab and click the Storage Reports button.

3. From the Report On drop-down menu, select NAS Mounts.

4. If you see a yellow warning message indicating that the report is not up to date, close the 
warning.

5. Click the Rescan vCenter Server for new inventory and storage devices icon.

6. In the Rescan Confirmation dialog box, click Yes.

The information about the NAS datastore is displayed in the report.

Option Action

Location Select the Training data center and click Next.

Type Select NFS and click Next.

Datastore name Type NFS-your_name. For example, NFS-Mike.

Server Type the NFS server host name or IP address.

Folder Type the path to the NFS datastore.

Mount NFS read only Leave the check box deselected. Mount the NFS datastore as 
read/write.

Click Next.

Host accessibility Select your VMware ESXi™ host from the list and click 
Next.

Ready to Complete Click Finish.
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Lab 11
Managing VMware vSphere VMFS :

Objective: Create and manage VMFS datastores

In this lab, you will perform the following tasks:

1. Change the Name of a VMFS Datastore

2. Review the Shared Storage Configuration

3. Create a VMFS Datastore

4. Expand a VMFS Datastore to Consume Unused Space on a LUN

5. Remove a VMFS Datastore

6. Extend a VMFS Datastore

Task 1: Change the Name of a VMFS Datastore

You can change the name of an existing VMware vSphere® VMFS datastore.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• VMware® vCenter™ Server Appliance™ name

• VMware® vCenter Server™ root password

• Your VMware ESXi™ host name

• Local datastore name
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1. If the VMware vSphere® Web Client is not already active, open a Web browser and connect to 
the vCenter Server Appliance home page at https://
vCenter_Server_Virtual_Appliance_name:9443/.

2. On the Login page, log in as root with the password and click Login.

3. Click the Home icon.

4. Select vCenter > Datastores.

5. Right-click the local datastore and select Rename.

6. Type Local-ESXi##, where ## is the number of your ESXi host. 

For example, for an ESXi host that ends in 02, the new name of the datastore is Local-ESXi02.

7. Click OK.

8. Verify that the new datastore name is displayed in the inventory.

Task 2: Review the Shared Storage Configuration

Display information about the shared storage in your lab environment.

Students should do the steps in this task individually.

1. Select vCenter > Hosts and Clusters > Lab Servers > Your_ESXi_host_name.

2. Click the Manage tab and click Storage.

3. Click Storage Adapters and select the iSCSI Software Adapter.

4. In the Adapter Details section, select the Paths tab and note the SCSI logical unit numbers 
(LUNs) that are available to your host. 

You use these LUNs to create datastores.

Task 3: Create a VMFS Datastore

VMFS datastores serve as repositories for virtual machines. You can set up VMFS datastores on any 
SCSI-based storage devices that the host discovers, including Fibre Channel, iSCSI, and local 
storage devices.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• First assigned LUN ID

• Second assigned LUN ID
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1. Select Home > vCenter > Hosts and Clusters > Lab Servers > ESXi_host_name.

2. Right-click the ESXi host and select New Datastore.

3. When prompted by the New Datastore wizard, perform the following actions.

4. Monitor the progress in the Recent Tasks pane and wait for the task to complete.

5. Right-click your ESXi host and select New Datastore.

6. When prompted by the Add Storage wizard, perform the following actions.

Option Action

Location Ensure that your ESXi host is listed and click Next.

Type Select VMFS and click Next.

Datastore name Type PrivateVMFS-##, where ## is the LUN number of your first 
assigned LUN listed in the class configuration handout. For example, 
if the LUN number of your assigned LUN ID is 1, the datastore name 
would be PrivateVMFS-01.

Select Disk/LUN Click your first assigned target/LUN number.

Click Next.

File System Version Keep the default of VMFS-5 and click Next.

Partition configuration Click the Datastore Size slider and reduce the LUN size by 1GB. 
For example, if the current disk size is 10GB, change the size to 
9GB. (You increase this VMFS datastore to its maximum size in 
task 4.)

Click Next.

Ready to Complete Click Finish.

Option Action

Location Ensure that your ESXi host is listed and click Next.

Type Select VMFS and click Next.
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7. Monitor the progress in the Recent Tasks pane and wait for the task to complete.

8. Select Home > vCenter > Storage > Training.

9. Select Related Objects > Datastores.

10. Verify that each new VMFS datastore is displayed in the datastore inventory.

11. In the datastore inventory, click the first PrivateVMFS-## datastore that you created. 

12. Click the Summary tab and record the value for Capacity. __________

Task 4: Expand a VMFS Datastore to Consume Unused Space on a 
LUN

When you need to create virtual machines on a datastore, or when the virtual machines running on a 
datastore require more space, you can dynamically increase the capacity of a VMFS datastore.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• First assigned LUN ID

1. Click the Manage tab of the first PrivateVMFS-## datastore that you created in task 3.

2. Click the Settings button.

3. Click Increase next to Capacity.

Datastore name Type PrivateVMFS-##, where ## is the LUN number of your 
second assigned LUN listed in the class configuration handout. For 
example, if the LUN number of your assigned LUN ID is 2, the 
datastore name would be PrivateVMFS-02. 

Select Disk/LUN Click your second assigned target/LUN number.

Click Next.

File System Version Keep the default of VMFS-5 and click Next.

Partition configuration Keep the default size and partition configuration.

Click Next.

Ready to Complete Click Finish.

Option Action
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4. When prompted by the Increase Datastore Capacity wizard, perform the following actions.

5. After the task is completed, review the datastore Summary tab and verify that the datastore size 
was increased to the maximum capacity (less space for system overhead).

Task 5: Remove a VMFS Datastore

You can delete any type of VMFS datastore, including copies that you have mounted without 
resignaturing. When you delete a datastore, it is destroyed and disappears from all hosts that have 
access to the datastore. 

Students should do the steps in this task individually.

1. In the inventory, right-click the PrivateVMFS-## datastore, where ## is the second LUN ID that 
is assigned to you. 

2. Select All vCenter Actions > Delete Datastore.

3. Click Yes to confirm datastore deletion.

4. Verify that the datastore was removed from the inventory.

Option Action

Select Device Select the first assigned LUN. This LUN should read Yes in the 
Expandable column. 

Click Next.

Specify Configuration From the Partition Configuration drop-down menu, select Use 
Free Space 1 GB to expand the datastore.

NOTE

The free space listed in the drop-down menu might be different 
in your environment.

Click Next.

Ready to Complete Review the information for accuracy and click Finish.



52 Lab 11 Managing VMware vSphere VMFS

Task 6: Extend a VMFS Datastore

A datastore can span over up to 32 extents (and can be called a multi-extent datastore). The size of 
each extent can be up to 64TB. The overall datastore size can be 64TB, but the datastore appears as 
a single datastore object.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• First assigned LUN ID

• Second assigned LUN ID

1. In the Datastore inventory, click the PrivateVMFS-## datastore, where ## is the number of your 
first assigned LUN ID. 

2. Click the Manage tab.

3. Under the Settings tab, click Increase next to Capacity. 

4. When prompted by the Increase Datastore Capacity wizard, perform the following actions.

5. When the task completes, click Device Backing and verify that two extents are displayed in the 
Extent Name pane. 

The Extent Name pane should show both of your assigned LUN IDs. 

6. Click the Summary tab.

7. In the Summary tab, record the new value for Total Capacity. __________

The value should differ from the value in task 3.

8. Rename this datastore VMFS-student_number where student number is the number of your 
assigned ESXi host.

9. Leave the vSphere Web Client open for the next lab.

Option Action

Select Device Select your second assigned LUN.

Click Next.

Specify Configuration From the Partition Configuration drop-down menu, select Use all 
available partitions.

Click Next.

Ready to Complete Review the information for accuracy and click Finish.
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Lab 12
Using Templates and Clones :

Objective: Deploy a virtual machine from a template and 
clone a virtual machine

In this lab, you will perform the following tasks:

1. Copy Sysprep Files to vCenter Server Appliance

2. Create a Template

3. Create Customization Specifications

4. Deploy a Virtual Machine from a Template

5. Clone a Virtual Machine that is Powered On

Task 1: Copy Sysprep Files to vCenter Server Appliance

The Sysprep files are an essential component of guest operating system customization. The Sysprep 
files are obtained from Microsoft and copied to VMware® vCenter™ Server Appliance™.

Students should do the steps in this task as a team from a single student desktop.

Use the following information from the class configuration handout:

• VMware® vCenter Server™ root password

1. On the desktop of your student virtual machine, double-click WinSCP.

2. Double-click Upload sysprep files to the vCVA.

3. If you receive a security warning, click Update to update the certificate.

4. If asked for a user name, type root.
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5. Type the administrator password and click OK.

6. Copy all the files from the Sysprep folder on the desktop to the vCenter Server Appliance 
/etc/vmware-vpx/sysprep/svr2003 directory.

7. After the file copy is complete, select Disconnect from the Session menu.

8. Close the WinSCP program.

Task 2: Create a Template

A virtual machine template serves as a template for creating new virtual machines.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• vCenter Server Appliance root password

1. If the VMware vSphere® Web Client is not already active, open a Web browser and connect to 
the vCenter Server Appliance home page at https://vCenter_Server_Appliance:9443/.

2. On the vCenter Server Appliance Login page, log in as root and type the administrator 
password.

3. Click Login.

4. Select vCenter > Virtual Machines.

5. Right-click the virtual machine named your_name##-1.

6. Click Shut Down Guest OS.

7. Click Yes to confirm shutdown and wait for the virtual machine to power off.

8. Right-click the virtual machine and select All vCenter Actions > Convert to Template.

9. Select vCenter > VM Templates.

10. Right-click the virtual machine named your_name##-1 and select Move To.

11. Expand VM Folders and select Templates.

12. Click OK.

13. Right-click the virtual machine template and click Rename.

14. Type your_name Template to change the template name and click OK.
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Task 3: Create Customization Specifications

A custom Sysprep answer file is a file that stores a number of customization settings such as 
computer name, licensing information, and workgroup or domain settings. You create a 
customization specification for template deployment. 

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• Windows product key

• vCenter Server root password

• Virtual machine administrator password

• Time zone

1. In the vSphere Web Client, click Home.

2. In the Monitoring panel, click Customization Specification Manager.

3. Click the Create a new specification icon (the left-most icon).

Option Action

Target VM Operating System Select Windows.

Customization Spec Name Type your_name-CustomSpec. Click Next.

Set Registration Information Type VMware Student for Name and VMware for 
Organization. Click Next.

Set Computer Name Click Use the virtual machine name and click Next.

Enter Windows License Type the Windows product key and leave all the other 
default values. Click Next.

Set Administrator Password Type the Windows administrator password. Retype the 
password in the Confirm password text box and click Next.

Time Zone Select the time zone and click Next.

Run Once Leave the default and click Next.

Configure Network Leave the default and click Next.

Set Workgroup or Domain Leave the default and click Next.
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4. Verify that your customization specification was created successfully.

Task 4: Deploy a Virtual Machine from a Template

Virtual machines can be rapidly deployed from templates saving time in creating new virtual 
machines. You deploy a virtual machine from your template and enable vCenter Server to customize 
the guest operating system. 

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• Shared VMware vSphere® VMFS datastore for virtual machines

1. In the vSphere Web Client, click Home.

2. Select vCenter > VM Templates.

3. Right-click your named template and select Deploy VM from this Template.

4. When prompted by the Deploy Template wizard, perform the following actions. 

Set Operating System Options Leave the default and click Next.

Ready to Complete Click Finish.

Option Action

Select a name Name the new virtual machine with your first name, followed 
by the number of your VMware ESXi™ host and the 
sequence number 2. For example, if Mike’s ESXi host is 
named ESXi01, the name of this virtual machine is Mike01-2.

Select a location Select the LabVMs folder and click Next.

Select a compute resource Expand the Lab Servers folder and click your ESXi host. 
Click Next.

Select a virtual disk format Keep the default.

Select a destination storage for 
the virtual machine files

Select the Shared VMFS datastore for virtual machines and 
click Next.

Option Action
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5. Repeat steps 3 and 4 and create another virtual machine. 

Name this virtual machine your_name##-3.

6. In the Recent Tasks pane on the right side of the vSphere Web Client, monitor the progress of 
the template deployment task. 

7. Select vCenter > Virtual Machines.

8. After you create these virtual machines, open a virtual machine console to each of your new 
virtual machines.

9. Verify that each virtual machine passes the following checks.

• The virtual machine boots up successfully. Wait at least 2 minutes for Sysprep to complete 
its tasks, which includes a reboot of the system.

• You can log in to the guest operating system as administrator with the virtual machine 
administrator password.

• VMware® Tools™ is installed.

• The cpubusy.vbs file is on the desktop.

10. Close the virtual machine console. Do not shut down the virtual machine.

Task 5: Clone a Virtual Machine that is Powered On

Cloning a virtual machine creates a duplicate of the virtual machine with the same configuration and 
installed software as the original. You can clone a virtual machine while it is powered off, powered 
on, or suspended.

Students should do the steps in this task individually.

Select clone options Select Customize the operating system.

Select Power on this virtual machine after creation.

Click Next.

Customize guest OS Select your_nameCustomSpec.

Click Next.

Ready to Complete Click Finish.

Option Action
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Use the following information from the class configuration handout:

• Local VMFS datastore for virtual machines

1. Right-click the your_name##-2 virtual machine and select Clone To Virtual Machine. 

2. When prompted by the Clone Virtual Machine wizard, perform the following actions.

3. Monitor the progress of the task in the Recent Tasks pane. 

4. Leave the vSphere Web Client open for the next lab.

Option Action

Name Name the new virtual machine Hot-Clone, followed 
by the number of your ESXi host, for example, Mike 
has an ESXi host named ESXi01. The name of this 
virtual machine is Hot-Clone01.

Inventory Location Select the LabVMs folder and click Next.

Select a compute resource Expand the Lab Servers folder and click your ESXi 
host. Click Next.

Select virtual disk format Keep the default.

Select a destination storage for the 
template files

Select the Local VMFS datastore for virtual machines, 
and click Next.

Select clone options Select Customize the operating system.

Select Power on this virtual machine after creation.

Click Next.

Customize guest OS Select your_nameCustomSpec.

Click Next.

Ready to Complete Click Finish.
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Lab 13
Modifying a Virtual Machine :

Objective: Modify a virtual machine’s hardware and add 
a raw LUN to a virtual machine

In this lab, you will perform the following tasks:

1. Increase the Size of a VMDK File

2. Adjust Memory Allocation on a Virtual Machine

3. Rename a Virtual Machine in the vCenter Server Inventory

4. Add a Raw LUN to a Virtual Machine

5. Expand a Thin-Provisioned Virtual Disk

Task 1: Increase the Size of a VMDK File

Increase the size of a virtual machine’s C: drive and configure the guest operating system to detect 
the additional space.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• VMware® vCenter™ Server Appliance™ host name

• VMware® vCenter Server™ root password

• Virtual machine administrator password
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1. If the VMware vSphere® Web Client is not already active, open a Web browser and connect to 
the vCenter Server Appliance home page at https://
vCenter_Server_Virtual_Appliance_name:9443.

2. On the vCenter Server Appliance Login page, log in as root with the password and click Login.

3. Select vCenter > Virtual Machines.

4. Verify that the Hot-Clone## virtual machine is powered on. 

5. If the virtual machine is not powered on, power it on now.

6. Right-click your Hot-Clone## virtual machine in the inventory and select Edit Settings. 

The Virtual Machine’s Edit Settings window is displayed.

7. In the Virtual Hardware list, select Hard Disk 1.

8. In Hard Disk 1, type 3GB and click OK.

9. Increase the size of the disk from within the guest operating system.

a. In the Summary tab, select Launch Console.

b. Log in to the guest operating system as Administrator, with the virtual machine 
administrator password.

c. On the virtual machine desktop, double-click My Computer. 

Q1. What is the total size of the C: drive?

1. For example, if you are using a vClass kit, this value is approximately 2GB.

d. Use Windows Explorer to open the C:\dell\ExtPart folder. 

e. Double-click the extpart.exe file. 

f. In Volume to extend, type C:.

g. In Size to expand the volume, type 1024 to extend the volume by 1,024MB.

h. On the virtual machine desktop, double-click My Computer to verify that the C: drive is 
extended. 

i. Record the value for the total size of the C: drive. __________

Q2. What is the difference between the values recorded in Q1 and Q2?

2. The value should differ by ~1GB.

j. Close the virtual machine’s console.
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Task 2: Adjust Memory Allocation on a Virtual Machine

You can add, change, or configure virtual machine memory resources or options to enhance virtual 
machine performance.

Students should do the steps in this task individually.

1. Right-click the Hot-Clone## virtual machine in the inventory and select Shut Down Guest OS.

2. Click Yes to confirm the shutdown.

3. After the virtual machine has shut down, right-click the virtual machine and select Edit Settings.

4. In the Virtual Hardware list, select the size value next to Memory. 

5. Change the value to 512 and ensure that MB is selected from the drop-down menu.

6. Click OK.

7. Click the virtual machine’s Summary tab to verify that the memory has increased.

Task 3: Rename a Virtual Machine in the vCenter Server Inventory

When you change the name of a virtual machine, you change the name used to identify the virtual 
machine in the vCenter Server inventory.

Students should do the steps in this task individually.

1. In the inventory, right-click your Hot-Clone## virtual machine and select Rename.

2. Rename the virtual machine to your_name##-4, where ## is the number of your VMware 
ESXi™ host. 

For example, if Greg has a host named ESXi01, the name of his virtual machine is Greg01-4.

CAUTION

Renaming a virtual machine in the inventory does not rename the virtual machine’s folder or the 
files in the virtual machine’s folder on the datastore.

Task 4: Add a Raw LUN to a Virtual Machine

A raw device mapping (RDM) enables a virtual machine to directly access and use a logical unit 
number (LUN).

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• Your raw LUN ID

• Virtual machine administrator password
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1. Add a raw LUN to the your_name##-2 virtual machine.

a. In the inventory, right-click the your_name##-2 virtual machine and select Edit Settings.

The Virtual Machine Edit Settings dialog box is displayed.

b. From the New Device drop-down menu, select RDM Disk and click Add.

c. In the Select Target LUN dialog box, select the assigned LUN.

d. Click OK.

e. Click the arrow next to New Hard disk to expand the new hard disk properties.

f. Configure the following properties for the new hard disk.

g. Click OK to close the Edit Settings dialog box.

2. Verify that the guest operating system can see the new disk.

a. Open a console to the virtual machine and log in as Administrator, with the virtual machine 
administrator password.

b. Select Start > Programs > Administrative Tools > Computer Management. 

c. Click Disk Management.

d. If a disk wizard starts, click Cancel.

e. Verify that Disk 1 is listed. 

Disk 1 is the RDM. You can now use the guest operating system utilities to format the 
drive. In this lab, you do not have to format the drive. 

f. Close the Computer Management window and close the virtual machine console.

Option Action

Location Select Store with the virtual machine.

Compatibility Mode Select Virtual.

Shares Keep the default.

Limit IOPs Keep the default.

Virtual Flash Keep the default.

Virtual Device Node Keep the default.

Disk Mode Keep the default.
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Task 5: Expand a Thin-Provisioned Virtual Disk

If you created a virtual disk in the thin format, you can convert the thin disk to a virtual disk in thick 
provision, eager-zeroed format.

Students should do the steps in this task individually.

1. Select Home > Hosts and Clusters > Training > Lab Servers > Your_ESXi_host_name.

2. Click the Related Objects tab and click Virtual Machines.

3. View and record the storage information for the virtual machine named your_name##-3.

• Provisioned Space __________

• Used Space __________

4. Click your_name##-3 and select the Summary tab.

5. Click the arrow next to Hard Disk 1 in the virtual machine hardware box and record the 
datastore. __________

6. Right-click your_name##-3 and select Shut Down Guest OS.

7. Click Yes to confirm shutdown.

8. Inflate the thin-provisioned virtual disk.

a. Select Home > Storage > Training. 

b. Right-click the datastore that you recorded in step 5 and select Browse Files.

c. Open the folder for the virtual machine named your_name##-3.

d. Right-click the your_name##-3.vmdk file and select Inflate. 

9. Wait for the operation to finish. 

10. Select Home > vCenter > Hosts and Clusters > Training > Lab Servers > 
Your_ESXi_host_name.

11. Click the Related Objects tab and click Virtual Machines.

12. Power on the virtual machine.

13. Observe the Used space and Provisioned space columns. 

The Size column displays a new value equal to the size of the virtual disk.

14. Leave the vSphere Web Client open for the next lab.
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Lab 14
Migrating Virtual Machines

Objective: Use vSphere vMotion and vSphere Storage 
vMotion to migrate virtual machines

In this lab, you will perform the following tasks:

1. Migrate Virtual Machine Files with vSphere Storage vMotion

2. Create a Virtual Switch and a VMkernel Port Group for vSphere vMotion Migration

3. Verify That Your ESXi Host Meets vSphere vMotion Requirements

4. Verify That Your Virtual Machines Meet vSphere vMotion Requirements

5. Perform a vSphere vMotion Migration of a Virtual Machine on a Shared Datastore

6. Perform a Cross-Host vSphere Storage vMotion Migration to a Local Datastore

7. Prepare for the Next Lab

Task 1: Migrate Virtual Machine Files with vSphere Storage vMotion

With VMware vSphere® Storage vMotion®, you can migrate a virtual machine and its disk files 
from one datastore to another while the virtual machine is running.

Students should do the steps in this task individually.

NOTE

Student A and student B will log in to the team VMware® vCenter Server™ system simultaneously 
because some of these tasks require cooperation. You should communicate with your teammate.
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Use the following information from the class configuration handout:

• vCenter Server root password

• Shared datastore

1. Open the VMware vSphere® Web Client. 

2. Log in to the team VMware® vCenter™ Server Appliance™ as root and type the password.

3. Select vCenter > Virtual Machines.

4. Migrate each of your virtual machines from your local datastore to the shared datastore.

a. Select your_name##-4 and click the Summary tab.

b. Under Storage in the Related Objects panel, record the datastore that the virtual machine 
resides on. __________

c. In the vSphere Web Client inventory, right-click the your_name##-4 virtual machine and 
click Migrate

d. When prompted by the Migrate Virtual Machine wizard, perform the following actions.

e. Monitor the progress of the task in the Recent Tasks pane. 

f. After the task is finished, click the Summary tab of the virtual machine that you migrated 
to verify that your virtual machine is on the new datastore.

Option Action

Select Migration Type Select Change Datastore.

Select a destination storage for the 
virtual machine files

Select the shared datastore that you recorded. 

Select a virtual disk format Keep the default. Click Next.

Ready to Complete Click Finish.
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Task 2: Create a Virtual Switch and a VMkernel Port Group for vSphere 
vMotion Migration

Create a virtual switch with a VMkernel port that can be used in VMware vSphere® vMotion® 
migrations.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• vmnic for the vSphere vMotion network

• vSphere vMotion IP address

• vSphere vMotion subnet mask

1. Select Home > vCenter > Hosts and Clusters.

2. In the vCenter Web Client inventory, expand Training > Lab Servers.

3. Select your VMware ESXi™ host in the inventory, and in the right pane click Manage.

4. Click Networking and ensure that the virtual switches tab is selected.

5. Click the icon Add Host Networking.

6. When prompted by the Add Network wizard, perform the following actions. 

7. Verify the configuration information for the new virtual switch in the Networking panel.

Option Action

Connection Type Select VMkernel Network Adapter. Click Next.

Select target device Select New standard switch. Click Next.

Create a Standard 
Switch

Click the + sign and add the adapter that you recorded. Click OK then 
click Next.

Port Properties Type vMotion for the Network Label.

Select the vMotion traffic check box under Available Services.

Click Next.

IP Address Select Use static IPv4 settings.

Type the vSphere vMotion IP address that you recorded.

Subnet Mask Type the vSphere vMotion subnet mask that you recorded. Click Next.

Ready to complete Confirm the settings and click Finish.
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Task 3: Verify That Your ESXi Host Meets vSphere vMotion 
Requirements

Verify that your ESXi host meets vSphere vMotion requirements.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• Shared datastore

1. Select Home > vCenter > Hosts and Clusters.

2. Select each ESXi host and click its Summary tab.

3. View the Processor Type information to verify that the CPUs are compatible.

4. Click your ESXi host’s Manage tab.

5. Verify that a vSphere vMotion port group exists and that it is configured with a speed and 
duplex of 1000Mb, Full Duplex.

a. Click the Networking button. 

b. Select vSwitch 2 and verify that a vSphere vMotion port group exists.

Verify that the port is a VMkernel port.

c. Verify that the physical adapter connected to the virtual switch has its speed and duplex 
defined as 1000 full.

6. Verify that both ESXi hosts have access to the same shared datastores.

a. Select Home > vCenter > Storage.

b. In the vCenter Web Client inventory, expand vcva01 > Training.

c. Select the shared datastore you recorded.

d. In the right pane, click Manage.

e. On the Manage tab, click Settings.

f. Click Connectivity and Multipathing.

g. Verify that both hosts are displayed in the table.
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Task 4: Verify That Your Virtual Machines Meet vSphere vMotion 
Requirements

Verify that a virtual machine’s settings meet vSphere vMotion requirements. 

Students should do the steps in this task individually.

1. Select Home > vCenter > VMs and Templates.

2. In your LabVMs folder, click the your_name##-2 virtual machine.

3. In the right pane, click Summary.

4. In the VM Hardware pane, click Edit Settings.

5. Verify that the virtual machine’s CD/DVD Drive 1 is not connected to a local device and does 
not have an image defined in a local datastore.

a. In the Hardware list, verify that the Summary column for CD/DVD Drive 1 shows Client 
Device.

b. If the Summary column does not show Client Device, select CD/DVD Drive 1 in the list 
and click Client Device to remove existing connections.

6. In the Hardware list, find Network Adapter 1. 

7. Verify that the virtual machine is either disconnected from the network or connected to a 
network accessible by the destination ESXi host (your partner’s ESXi host).

8. Check the Hardware list for a hard disk that is labeled Hard Disk 2.

a. If you have such a disk, point to the disk.

b. After a moment, click the x button that appears at the right side of the row for Hard Disk 2.

c. Select the Delete files from datastore check box.

This raw device mapping (RDM) hard disk was added in a previous lab and must be 
removed because it is a private LUN and the other ESXi host cannot access it. You perform 
this step so that the virtual machine will be compatible with vSphere vMotion.

9. Verify that CPU affinity is not set.

a. Click the arrow next to CPU to expand the advanced CPU options. 

b. If the Scheduling Affinity panel displays a number, delete the number.

10. Click OK to apply all virtual machine changes.

11. Repeat this task for all your other virtual machines.
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Task 5: Perform a vSphere vMotion Migration of a Virtual Machine on a 
Shared Datastore

Migration with vSphere vMotion allows virtual machine processes to continue working throughout a 
migration.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• ESXi host to which to migrate virtual machines 

• Virtual machine administrator password

1. Select Home > vCenter > Hosts and Clusters.

2. Expand the vCenter Server inventory view by clicking on the arrow next to your ESXi host so 
that you can see all your virtual machines.

3. If the your_name##-2 virtual machine is powered off, right-click your_name##-2 and select 
Power On.

4. After the virtual machine is powered on, right-click your_name##-2 and select Open Console.

5. Log in to the virtual machine with the administrator account and password that you recorded.

6. Open a command prompt on the virtual machine.

7. Type the ipconfig command and record the virtual machine’s default gateway. _________

8. Type ping -t default_gateway that you recorded in step 7 and press Enter to start a 
continuous ping of the virtual machine’s default gateway.

9. Leave the virtual machine console open and return to the vSphere Web Client.

10. Migrate your_name##-2 to your partner’s ESXi host.

a. Right-click the virtual machine named your_name##-2 and select Migrate.

b. When prompted by the Migrate Virtual Machine wizard, perform the following actions.
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11. Return to the virtual machine console. Arrange the windows so that you can observe both the 
virtual machine console and the Recent Tasks pane in vSphere Client. 

12. Monitor the command prompt in the virtual machine and verify that no pings are dropped 
during the migration.

13. In the Recent Tasks pane, monitor the progress of the virtual machine migration.

14. After the Relocate virtual machine task is complete in the Recent Tasks pane, press CTRL+C in 
the cmd window of the virtual machine console to stop the ping.

15. Close the virtual machine console and return to the vSphere Web Client.

16. Verify that your virtual machine is displayed under your partner’s ESXi host in the inventory.

17. If your other virtual machines are powered off, power them on now.

18. Use vSphere vMotion and verify that your other virtual machines can be migrated successfully 
to your partner’s ESXi host.

19. Migrate your_name##-2 back to your ESXi host.

Option Action

Select Migration Type Select Change host.

Select Destination Expand the inventory view and select the ESXi host that you 
recorded to which you want to migrate virtual machines.

The migration requirements are validated. If the validation does 
not succeed, you receive warning or error messages. You cannot 
continue with the migration until the errors are resolved.

NOTE

One reason that the validation might not succeed is if an RDM 
resides in a private LUN. See task 4, step 8.

vMotion Priority Leave the default value and click Next.

Ready to Complete Click Finish.
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Task 6: Perform a Cross-Host vSphere Storage vMotion Migration to a 
Local Datastore

vSphere vMotion migration to another host and datastore is possible in VMware vSphere® 
environments without shared storage.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• ESXi host to which to migrate virtual machines

• Local datastore name

1. Select Home > vCenter > Hosts and Clusters.

2. Expand the vCenter Server inventory view by clicking the arrow next to your ESXi host so that 
you can see all your virtual machines.

3. Migrate your_name##-2 to your partner’s ESXi host.

a. Click the virtual machine named your_name##-2 and select Migrate.

NOTE

If your_name##-2 is powered off, power it on before beginning the vSphere vMotion 
migration.

b. When prompted by the Migrate Virtual Machine wizard, perform the following actions.

4. In the Recent Tasks pane, monitor the progress of the virtual machine migration.

5. Verify that your virtual machine is displayed under your partner’s ESXi host in the inventory.

Option Action

Select Migration Type Select Change both host and datastore. Click Next.

Select Destination Expand the inventory view and select the ESXi host that you 
recorded to which you want to migrate virtual machines.

Select Datastore Select the local datastore.

vMotion Priority Leave the default value. Click Next.

Ready to Complete Click Finish.
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Task 7: Prepare for the Next Lab

Migrate all your virtual machines back to your host. 

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• Shared datastore name

1. Select Home > vCenter > Hosts and Clusters.

2. Expand the vCenter Server inventory view so that you can see all your virtual machines.

3. Migrate each of your virtual machines back to your ESXi host.

a. If any of your virtual machines are powered off, power it on before performing the vSphere 
vMotion migration.

b. Click your virtual machine and select Actions > Migrate.

c. When prompted by the Migrate Virtual Machine wizard, perform the following actions.

4. In the Recent Tasks pane, monitor the progress of the virtual machine migration.

5. Verify that your virtual machines are displayed under your ESXi host in the inventory.

6. Close the vSphere Web Client.

Option Action

Select Migration Type Select Change host or Change host and datastore for the 
virtual machine you migrated to local storage.

Select Destination Expand the inventory view and select your ESXi host.

Datastore Select Shared datastore.

vMotion Priority Leave the default value.

Ready to Complete Click Finish.
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Lab 15
Managing Virtual Machines :

Objective: Perform several virtual machine management 
tasks

In this lab, you will perform the following tasks:

1. Unregister a Virtual Machine in the vCenter Server Inventory

2. Register a Virtual Machine in the vCenter Server Inventory

3. Unregister and Delete Virtual Machines from Disk

4. Take Snapshots of a Virtual Machine

5. Revert to a Snapshot

6. Delete an Individual Snapshot

7. Use the Delete All Function in Snapshot Manager

Task 1: Unregister a Virtual Machine in the vCenter Server Inventory

Unregistering a virtual machine from the inventory unregisters it from the host and VMware® 
vCenter Server™ inventory, but does not delete it from the datastore.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• VMware® vCenter™ Server Appliance™ system name

• vCenter Server root password
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1. If the VMware vSphere® Web Client is not already active, open a Web browser and connect to 
the vCenter Server Appliance page at https://vCenter_Server_Appliance_name:9443/.

2. On the Login page, log in as root with the password that you recorded and click Login.

3. Select vCenter > Virtual Machines.

4. Click your_name##-4, where ## is the number of your VMware ESXi™ host, and click the 
Summary tab.

5. From the Related Object panel in the Summary tab, record the VMFS datastore name where 
the virtual machine resides. __________

6. Right-click your_name##-4 and select Shut Down Guest OS.

7. After the virtual machine has shut down, right-click your_name##-4 and select All vCenter 
Actions > Remove from Inventory.

CAUTION

Do not select Delete from Disk. This operation is not recoverable.

8. Click Yes to confirm the removal and verify that your_name##-4 is no longer displayed in the 
inventory.

9. Select Home > vCenter > Datastores.

10. Select the VMware vSphere® VMFS datastore under the Objects tab on which your_name##-4 
is located and select the Navigate to the datastore file browser icon.
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11. View the folders in the Datastore browser.

Q1. Is there a folder named your_name##-4?

1. Yes, there is a folder named your_name##-4. When the virtual machine was first created, it 
and its folder were named Hot-Clone##. When the virtual machine was renamed to 
your_name##-4, its folder's name was not renamed. Only when the virtual machine was migrated 
to a new datastore was the folder automatically renamed to your_name##-4.

12. Click the yourname##-4 folder to view the virtual machine files. 

13. Leave the Datastore browser open for the next task.

Task 2: Register a Virtual Machine in the vCenter Server Inventory

If you removed a virtual machine from the vCenter Server inventory but did not remove it from the 
managed host’s datastore, you can return it to the vCenter Server inventory by registering it with the 
vCenter Server system.

Students should do the steps in this task individually.

1. In the list of files to the right of the Folders pane, right-click the yourname##-4.vmx file and 
select Register VM.

2. When prompted by the Add to Inventory wizard, perform the following actions.

3. Verify that the virtual machine is placed back in the inventory.

a. Select Home > vCenter > VMs and Templates.

b. Verify that your_name##-5 is in your LabVMs folder.

Option Action

Name & Location Type your_name##-5, where ## is the number of your ESXi host.

In the Inventory Location pane, select your LabVMs folder. Click Next.

Host/Cluster Select your ESXi host. Click Next.

Ready to Complete Click Finish.
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Task 3: Unregister and Delete Virtual Machines from Disk

You use the Delete from Disk option to remove a virtual machine from the vCenter Server inventory 
and delete all virtual machine files, including the configuration file and virtual disk files, from the 
datastore.

Students should do the steps in this task individually.

1. Select the your_name##-5 virtual machine in the inventory and click the Summary tab. 

2. Record the VMFS datastore name on which this virtual machine resides. __________

3. Right-click your_name##-5 and select All vCenter Actions > Delete from Disk. 

4. Click Yes to confirm the deletion and verify that your_name##-5 is no longer displayed in the 
inventory. 

5. Select Home > vCenter > Datastores.

6. Select the VMFS datastore on which your_name##-5 was located and click the Navigate to the 
datastore file browser icon.

7. Verify that the virtual machine files no longer exist. 

The folder has the original virtual machine name: your_name##-4.

Task 4: Take Snapshots of a Virtual Machine

Snapshots preserve the state and data of a virtual machine at the time you take the snapshot. 
Snapshots are useful when you must revert repeatedly to the same virtual machine state, but you do 
not want to create multiple virtual machines.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• Virtual machine Administrator password

• Third-party software ISO location

1. Select Home > vCenter > Virtual Machines.

2. Right-click the your_name##-3 virtual machine, and select Open Console. 

3. Log in as Administrator, with the virtual machine administrator password that you recorded.

4. Drag the iometer.exe file to the Recycle Bin. 

5. To remove the iometer.exe file, right-click the Recycle Bin icon and select Empty Recycle 
Bin. 

6. Click Yes to confirm the file deletion and leave the virtual machine console open.
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7. In the vSphere Web Client, right-click the your_name##-3 virtual machine and select Take 
Snapshot.

8. When prompted by the Take Virtual Machine Snapshot wizard, perform the following actions.

9. Click OK and monitor the task in the Recent Tasks pane.

10. Return to the virtual machine console and drag the cpubusy.vbs file to the Recycle Bin. 

11. To remove the cpubusy.vbs file, right-click the Recycle Bin icon and select Empty Recycle 
Bin.

12. Click Yes to confirm the file deletion and leave the virtual machine console open.

13. Return to the vSphere Web Client and take another snapshot of this virtual machine by right-
clicking the virtual machine and clicking Take Snapshot.

14. When prompted by the Take Virtual Machine Snapshot wizard, perform the following actions.

15. Click OK and monitor the task in the Recent Tasks pane.

Option Value

Name Type Without iometer.

Description Type Deleted iometer.exe.

Snapshot the virtual machine’s memory Click to deselect.

Quiesce guest file system (Needs VMware Tools installed) Leave deselected.

Option Action

Name Type Without iometer and cpubusy.

Description Type Deleted cpubusy.vbs.

Snapshot the virtual machine’s memory Click to deselect.

Quiesce guest file system (Needs 
VMware Tools installed)

Leave deselected.
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16. If ClassFiles-vSphere.iso is not already connected, connect ClassFiles-vSphere.iso 
to your virtual machine’s CD-ROM drive.

a. Right-click the virtual machine and select Edit Settings. 

b. Select CD/DVD Drive 1 > Datastore ISO file.

c. Navigate to the software ISO location that you recorded.

d. Select the Classfiles-vSphere.iso ISO image and click OK.

e. Select Connected next to CD/DVD Drive 1.

f. Click OK to close the Edit Settings dialog box.

17. View your virtual machine console. 

18. If autorun does not open the CD-ROM, use Windows Explorer and go to the CD-ROM drive 
(D:).

19. Copy the cpubusy.vbs file from the CD-ROM drive (D:) to the virtual machine’s desktop.

20. Disconnect from Classfiles-vSphere.iso on the CD-ROM drive.

a. Right-click the virtual machine in the inventory and select Edit Settings.

b. In the Virtual Hardware list, select the drop-down menu next to CD/DVD Drive 1.

c. Select Client Device and click OK.

21. Right-click the virtual machine in the inventory and take another snapshot of this virtual 
machine by clicking Take Snapshot.

22. When prompted by the Take Virtual Machine Snapshot wizard, perform the following actions.

23. Click OK and monitor the task in the Recent Tasks pane.

24. Right-click the virtual machine and select Manage Snapshots.

You should see three snapshots.

25. Leave the Snapshot Manager open.

Option Action

Name Type With cpubusy.

Description Type Added cpubusy.vbs.

Snapshot the virtual machine’s memory Leave selected.

Quiesce guest file system (Needs VMware Tools installed) Leave deselected.
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Task 5: Revert to a Snapshot

The Revert to feature enables you to return a virtual machine to the time when the selected snapshot 
was created.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• Virtual machine administrator password

1. In the Snapshot Manager, select the snapshot named Without iometer and cpubusy and 
click Revert to. 

2. Click Yes to confirm that you want to revert to Without iometer and cpubusy. 

3. Click Close to close the Snapshot Manager. 

Q1. Did the virtual machine power off and what is the reason?

1. Yes. Because the memory state was not preserved.

4. Start your virtual machine by right-clicking the virtual machine and selecting Power On. 

5. Log in to your virtual machine as Administrator with the virtual machine administrator 
password that you recorded.

Q2. Do you see either iometer.exe or cpubusy.vbs on the desktop?

2. No.

6. In the vSphere Web Client, right-click the virtual machine and select Manage Snapshots. 

You should see that the You Are Here pointer has been placed below the snapshot named 
Without iometer and cpubusy.

7. In the Snapshot Manager, select the snapshot named With cpubusy and click Revert to. 

8. Click Yes to confirm that you want to revert to With cpubusy. 

9. Click Close to close the Snapshot Manager. 

Q3. Did the virtual machine power off and what is the reason?

3. No. Because the memory state was preserved.

Q4. Do you see cpubusy.vbs on the desktop?

4. Yes.

Q5. Do you see iometer.exe on the desktop?

5. No.
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Task 6: Delete an Individual Snapshot

Deleting a snapshot removes the snapshot from the Snapshot Manager. The snapshot files are 
consolidated and written to the parent snapshot disk.

Students should do the steps in this task individually.

1. Right-click the virtual machine and select Manage Snapshots. 

You should see that the You Are Here pointer has been placed below the snapshot named With 
cpubusy.

2. In the Snapshot Manager, click the snapshot named Without iometer and cpubusy and 
click Delete. 

3. Click Yes to confirm that you want to delete Without iometer and cpubusy.

4. Click Close to close the Snapshot Manager.

Q1. Did the virtual machine power off?

1. No.

Q2. Do you see cpubusy.vbs on the desktop?

2. Yes.

Task 7: Use the Delete All Function in Snapshot Manager

Delete All consolidates and writes changes between snapshots and previous delta disk states to the 
base parent disk and merges them with the base virtual machine disk.

Students should do the steps in this task individually.

1. Right-click the virtual machine and select Manage Snapshots. 

You should see that the You Are Here pointer has been placed below the snapshot named With 
cpubusy.

2. In the Snapshot Manager, click the Delete All button. 

3. Click Yes to confirm that you want to delete all the remaining snapshots.

Q1. Were all the remaining snapshots deleted from the Snapshot Manager?

1. Yes.
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4. Click Close to close the Snapshot Manager.

Q2. Do you see cpubusy.vbs on the desktop and what is the reason?

2. Yes. The current state of the virtual machine was not altered. All that happened was that 
snapshots were removed. There is no longer an option to revert to those earlier points in time.

5. Close the virtual machine console.
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Lab 16
Managing VMware vSphere vApps :

Objective: Perform vApp management tasks

In this lab, you will perform the following tasks:

1. Create a vApp

2. Power on a vApp

3. Remove a vApp

Task 1: Create a vApp

VMware vSphere® vApp™ is a container, like a resource pool and can contain one or more virtual 
machines. A vApp also shares some functionality with virtual machines.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• VMware® vCenter Server™ root password

1. If the VMware vSphere® Web Client is not already active, open a Web browser and connect to 
the VMware® vCenter™ Server Appliance™ page at https://vCenter_Server_Appliance:9443/.

2. On the vCenter Server Appliance login page, log in as root and type the root password.

3. Click Login.

4. Select Home > vCenter > Virtual Machines.

5. Right-click your_name##-2 and select Shut Down Guest OS. 

6. Click Yes to confirm the shutdown.
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7. Repeat steps 5–6 to shut down your_name##-3. 

Wait until both virtual machines have been powered off.

8. Select Home > vCenter > vApps.

9. Click the Create a New vApp icon.

10. When prompted by the New vApp wizard, perform the following actions.

11. Select Home > vCenter > VMs and Templates.

12. Expand Lab VMs. 

13. Verify that the vApp appears in the inventory.

14. Drag the virtual machine named your_name##-2 to your vApp.

15. Drag the virtual machine named your_name##-3 to your vApp.

Q1. Do you see your_name##-2 or your_name##-3 on the left side of the vSphere 
Web Client in the VMs and Templates view?

1. You see the vApp, but not the virtual machines themselves.

16. Select Home > vCenter > Hosts and Clusters.

Option Action

Creation type Select Create a new vApp. Click Next.

Select destination Select your VMware ESXi™ host. Click Next.

App Name Type your_name-vApp.

Select folder Select the Lab VM folder. Click Next.

Resource allocation Leave the defaults. Click Next.

Ready to Complete Click Finish.
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17. Expand the vApp. 

18. Click the Related Objects tab and click the Virtual Machines button.

Q2. Do you see your_name##-2 and your_name##-3 on the right side of the 
vSphere Web Client in the Virtual Machines view?

2. Yes. You can see the vApp and the virtual machines that the vApp contains.

19. Select Home > vCenter > VMs and Templates.

20. Right-click the vApp and select Edit Settings.

21. Click the right arrow next to Start Order to expand the options.

22. Select your_name##-2 and click the down arrow twice. 

your_name##-2 is placed in group 2.

23. Verify that your_name##-3 is displayed first, in group 1.

24. Select your_name##-3 and change the value in the Startup sequence proceeds when text box 
from 120 to 20 (seconds) and press Enter.

25. Select your_name##-2 and change the value in the Startup sequence proceeds when text box 
from 120 to 20 (seconds) and press Enter.

26. Click OK.

Task 2: Power on a vApp

A vApp can power on and power off, and can also be cloned.

1. Right-click the vApp and select Power On.

2. Monitor the tasks in the Recent Tasks pane.

Q1. Do the virtual machines power on at the same time?

1. No. The first virtual machine powers on and about 20 seconds later, the second virtual 
machine powers on.
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Task 3: Remove a vApp

Remove the vApp that you created.

Use the following information from the class configuration handout:

• vCenter Server Appliance root password

1. Right-click the vApp and select Shut Down. 

2. Click Yes to confirm the shutdown.

3. Select Home > vCenter > Hosts and Clusters.

4. Expand the vApp. 

5. Drag your_name##-2 from your vApp to your host.

6. Repeat step 5 for your_name##-3.

7. Right-click the vApp and select All vCenter Actions > Delete from Disk.

8. Click Yes to confirm the deletion.

9. Leave the vSphere Web Client open for the next lab.
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Lab 17
User Permissions :

Objective: Use a custom user role

In this lab, you will perform the following tasks:

1. Create a Custom Role in vCenter Server

2. Assign Permissions on vCenter Server Inventory Objects

3. Verify Permission Usability

Task 1: Create a Custom Role in vCenter Server

You can create custom roles by using the role-editing facilities in the VMware vSphere® Web Client 
to create privilege sets that match your user needs.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• VMware® vCenter™ Server Appliance™ root password

1. Use the vSphere Web Client to log in to your team vCenter Server system as user root, with the 
password that you recorded.

2. Select Home > Administration > Roles.

3. Click the Create Role icon. 

The Create Role dialog box is displayed.

4. In Role name, type VM Creator-your_name.
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5. In the Privileges pane, select the following privileges.

6. Click OK to add the role.

Task 2: Assign Permissions on vCenter Server Inventory Objects

Permissions are access roles that consist of a user and the user’s assigned role for an object such as a 
virtual machine.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• Active Directory (AD) domain

• Your nonprivileged domain account name

• Datastore for domain users

1. Select Home > vCenter > VMs and Templates.

2. Select your LabVMs folder.

3. Click the Manage tab and click the Permissions tab.

4. In the Permissions tab, click the Add Permissions icon. 

The Assign Permissions dialog box is displayed. 

5. Click Add.

Option Action

Datastore Select Allocate space.

Network Select Assign network.

Resource Select Assign virtual machine to resource pool.

Virtual machine > Configuration Select Add new disk.

Select Add or remove device.

Select Memory.

Virtual machine > Interaction Select All privileges. Select Interaction to include all 
privileges in this subcategory.

Virtual machine > Inventory Select Create new.
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6. From the drop-down menu in the Domain panel, select the AD domain that you recorded.

7. In the Users and Groups panel, select the user name of the nonprivileged domain account that 
you recorded. 

8. Click Add.

9. Click OK to continue.

10. In the Assigned Role panel, click the VM Creator - your_name role.

11. Leave the Propagate to children check box selected and click OK.

12. Verify that the permission appears in the Permissions tab.

NOTE

Note that you assigned your custom role to a specific folder. In the steps that follow, you assign 
the custom role to a specific host, datastore, and network. As a result, the user can create virtual 
machines, but only in the specified folder, host, datastore, and network. On the other hand, you 
can assign the role on an object higher in the vCenter Server inventory, such as the vCenter 
Server object. This role assignment enables the user to create virtual machines in any folder, 
host, datastore, and network.

13. Select Home > vCenter > Hosts and Clusters.

14. Select your VMware ESXi™ host in the inventory.

15. Click the Manage tab and click the Permissions tab.

16. Add the permission using steps 4–11.

17. Select Home > vCenter > Datastores.

18. Select the datastore for the domain users that you recorded and click the Permissions tab.

19. Add the permission using steps 4–11.

20. Select Home > vCenter > Standard Networks.

21. Select the Production network.

22. Click the Manage tab and click the Permissions tab.

23. Add the permission using steps 4–11.
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Task 3: Verify Permission Usability

Permissions grant users the right to perform the activities specified by the role on the object to which 
the role is assigned.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• Your nonprivileged domain account name

• Your nonprivileged domain account password

• ESXi host

• Datastore for domain users

• Guest operating system

1. In the upper-right corner of the vSphere Web Client, note that you are logged in as root.

2. Click the drop-down menu next to root@localos and click Logout.

3. Log in to your vCenter Server system with the nonprivileged domain user name and password 
that you recorded.

4. In the upper-right corner of the vSphere Web Client, note that you are logged in as the 
nonprivileged domain user.

5. Select Home > vCenter > VMs and Templates. 

LabVMs is the only folder that you see.

6. Right-click your LabVMs folder and select New Virtual Machine.

7. When prompted by the Create New Virtual Machine wizard, perform the following actions.

Option Action

Select a creation type Click Create a new virtual machine and click Next.

Select a Name and folder Type your_name-Temp, where your_name is your first name 
(for example, Mike-Temp).

Inventory Location Ensure that the Lab VMs folder is selected.

Click Next.

Select a compute resource Expand the Lab Servers folder, select the ESXi host that you 
recorded, and click Next.
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8. Monitor the progress of the task in the Recent Tasks pane.

Q1. Which inventory objects are available for the user?

1. Only the LabVMs folder, their ESXi host, your datastore, and the ProdVMs network were 
available. 

9. After the task is completed, verify that the virtual machine was created successfully.

10. Right-click your virtual machine in the inventory. 

Familiarize yourself with the options that the role does not permit. For example, the All 
vCenter Actions > Delete from Disk option is unavailable.

11. Log out of the vSphere Web Client where you are logged in as the domain user.

Select storage Select the datastore for domain users that you recorded. The other 
datastores are not displayed in the list. Click Next.

Select compatibility Ensure that Compatible with ESXi 5.5 and later is selected and 
click Next.

Guest Operating System Select the guest operating system that you recorded and click 
Next.

Customize hardware Select the following options.

CPU Leave the defaults.

Memory Select MB from the drop-down menu and type 4.

New Hard disk Note the options that are not available to you. Leave the default.

Disk Size In Capacity, type 2 and leave the default at GB.

Note that the Disk Provisioning option is unavailable.

Leave the default setting for Location.

New Network Verify that Production is the only option on the drop-down menu 
for NIC 1. Leave all other options at their default settings. Click 
Next.

Ready to Complete Click Finish.

Option Action
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12. Log in to the vSphere Web Client instance as root.

13. Select Home > vCenter > Hosts and Clusters.

14. Right-click the virtual machine your_name-Temp and select All vCenter Actions > Delete 
from Disk. 

15. Click Yes to confirm deletion.
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Lab 18
Resource Pools :

Objective: Create and use resource pools on an ESXi 
host by using vCenter Server

In this lab, you will perform the following tasks:

1. Create CPU Contention

2. Create a Resource Pool Named Fin-Test

3. Create a Resource Pool Named Fin-Prod

4. Verify Resource Pool Functionality

Task 1: Create CPU Contention

CPU contention is the state of multiple virtual machines competing for limited logical CPU 
resources and being forced by the VMKernel to share, possibly resulting in poorer virtual machine 
performance.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• VMware® vCenter™ Server Appliance™

• VMware® vCenter Server™ root password

1. If the VMware vSphere® Web Client is not already active, open a Web browser and connect to 
the vCenter Server Appliance page at https://vCenter_Server_Virtual_Appliance:9443/. 

2. Log in as root with the password that you recorded.
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3. Select Home > vCenter > VMs and Templates.

4. Power on your virtual machines your_name##-2 and your_name##-3 if they are powered off 
and ensure that your virtual machines are running on your host.

5. Open a console to the virtual machines your_name##-2 and your_name##-3 and log in as 
Administrator.

6. On each virtual machine’s desktop, to start an instance of the cpubusy.vbs script, right-click 
the script and select Open with Command Prompt.

This script runs continuously. Wait 1 to 2 minutes for it to stabilize. This script repeatedly does 
floating-point computations. The script also displays the duration (wall-clock time) of a 
computation. For example:

I did three million sines in 2 seconds!

Use the number of seconds reported as a performance estimate. You should find that the 
program runs at approximately the same rate in each virtual machine.

7. In the inventory view, right-click the your_name##-2 virtual machine and select Edit Settings.

8. In the Virtual Hardware tab, expand the CPU properties.

9. In the Scheduling Affinity section, type 1 in the space provided. 

The virtual machine will run only on processor 1. 

10. Click OK.

CAUTION

CPU affinity is used mainly to create CPU contention for training purposes. Use of this feature 
in a production environment is strongly discouraged.

11. Repeat steps 7 through 10 to set the scheduling affinity for the other virtual machine, 
your_name##-3.

Force the virtual machine to use the same processor as the first virtual machine (processor 1). 
Allow cpubusy.vbs to run for a minute or two.

Use the number of seconds reported as a performance estimate. You should find that the 
program runs at approximately the same rate in each virtual machine.
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Task 2: Create a Resource Pool Named Fin-Test

Resource pools allow you to delegate control over resources of a host.

Students should do the steps in this task individually.

1. Select Home > vCenter > Hosts and Clusters.

2. Right-click your VMware ESXi™ host and select All vCenter Actions > New Resource Pool.

3. Perform the following actions to assign properties to the resource pool.

4. Click OK.

Task 3: Create a Resource Pool Named Fin-Prod

Resource pools enable you to delegate control over resources of a host.

Students should do the steps in this task individually.

1. Select Home > vCenter > Hosts and Clusters.

2. Right-click your ESXi host in the inventory and select All vCenter Actions > New Resource 
Pool.

3. Perform the following actions to assign properties to the resource pool.

4. Click OK.

Option Action

Name Type Fin-Test.

CPU Resource Shares Select Low from the drop-down menu.

All other settings Leave the defaults.

Option Action

Name Type Fin-Prod.

CPU Resource Shares Select High from the drop-down menu.

All other settings Leave the default.
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Task 4: Verify Resource Pool Functionality

You can add an existing virtual machine to a resource pool.

Students should do the steps in this task individually.

1. Select Fin-Test in the inventory and click the Summary tab. 

2. View the CPU Resource Settings panel.

Q1. What is the number of shares for this resource pool?

1. 2,000

3. Select Fin-Prod and click the Summary tab. 

4. View the Resource Settings panel.

Q2. What is the number of shares for this resource pool?

2. 8,000

5. Drag your_name##-2 to the Fin-Prod resource pool.

6. Drag your_name##-3 to the Fin-Test resource pool.

7. View the results of cpubusy.vbs in each virtual machine console.

Q3. What is the difference in performance between the virtual machines?

3. The Fin-Test resource pool (and thus the virtual machine in it) has only one-fourth of the CPU 
shares that the Fin-Prod resource pool has. So the virtual machine in the Fin-Test resource pool 
receives only one-fourth of the CPU cycles of the logical CPU to which the virtual machines are 
pinned. Note: In the past, bugs have required that the virtual machines be powered off before 
being dragged to the resource pool.

8. To change CPU shares of the Fin-Test resource pool from Low to Normal, right-click the Fin-
Test resource pool in the inventory and click Settings. 

9. Click Edit in the CPU Resource pane and change shares to Normal from the drop-down menu. 

10. Click OK. 

Leave CPU shares at High for the Fin-Prod resource pool.

11. Run the scripts for a few seconds and compare the performance of the script in each virtual 
machine. 

12. If CPU contention occurs, you see a difference in performance between the virtual machines.

13. Using steps 6 through 8, change CPU shares of the Fin-Prod resource pool from High to 
Normal.

14. To stop the cpubusy.vbs scripts in each virtual machine, press Ctrl+C in each cpubusy window.

15. Leave the vSphere Web Client open for the next lab.
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Lab 19
Monitoring Virtual Machine Performance :

Objective: Demonstrate that system-monitoring tools 
reflect CPU workload

In this lab, you will perform the following tasks:

1. Create CPU Activity

2. Use vSphere Web Client to Monitor CPU Utilization

3. Undo Changes Made to the Virtual Machines

Task 1: Create CPU Activity

Run the cpubusy.vbs script in each virtual machine to create a heavy CPU load.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• VMware® vCenter™ Server Appliance™

• VMware® vCenter Server™ root password

1. Use a Web browser to connect to the VMware vSphere® Web Client URL.

2. Log in as user root with the team vCenter Server root password.
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3. In the left navigation pane, select Home > vCenter > VMs and Templates. 

4. Expand the view under your vCenter Server to show your virtual machines.

5. Maximize the consoles to the your_name##-2 and your_name##-3 virtual machines and log in 
as Administrator. 

6. On each virtual machine’s desktop, to start an instance of the cpubusy.vbs script, right-click 
the script and select Open with Command Prompt.

Task 2: Use vSphere Web Client to Monitor CPU Utilization

You monitor CPU, memory, disk, network, and storage metrics by using the performance charts.

Students should do the steps in this task individually.

1. Click your_name##-2 in the inventory. 

2. Click the Monitor tab and click the Performance tab. 

The Overview view is displayed by default.

3. Click the Advanced button. 

By default, the Advanced panel shows CPU usage in real time.

4. Click the Chart Options link. 

5. If you cannot see the Chart Options link, unpin the right column to make the link visible. 

6. Click the Chart Options link.

The Customize Performance Chart dialog box is displayed.

7. Select CPU.

8. In the Timespan drop-down menu, select Real-time.

9. In the Target Objects pane on the right, deselect the check box with the virtual machine’s name.

10. In the Counters pane, click None to deselect all selected counters. 
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11. Select the Used and Ready counters.

12. Click OK. 

The chart is displayed.

13. Open a new tab in your Web browser and open a second instance of the vSphere Web Client by 
navigating to the vSphere Web Client URL.

You are not required to retype your connection credentials.

14. Select your_name##-3 in the inventory. 

15. Click the Monitor tab and click the Performance tab.

16. Configure the CPU Performance graph for your_name##-3 and select the same chart options 
that you selected in steps 2 through 10.

Each Web browser window now shows the configured chart for one of your virtual machines.

17. In the Web browser window for each virtual machine, point to the end of the line graph to view 
the current CPU ready value.

18. Record the current CPU ready value for each virtual machine.

• your_name##-2 __________

• your_name##-3 __________

Leave the Performance Chart windows open.
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19. To stop the cpubusy.vbs scripts in each virtual machine, press Ctrl+C in each cpubusy 
window.

CAUTION

Ensure that this script is stopped in each virtual machine. If the script is still running, it affects 
the next lab. 

20. In the Web browser window for each virtual machine, point to the end of the line graph to view 
the current CPU ready value. 

NOTE

Wait for the chart to be updated. Performance charts update every 20 seconds.

Q1. Did the CPU ready value change and, if it did, what is the reason for the 
change?

1. Yes. The CPU ready value should decrease significantly because the CPU contention that 
was created by running the cpubusy.vbs script was terminated.

Task 3: Undo Changes Made to the Virtual Machines

Undo changes made to each virtual machine.

Students should do the steps in this task individually.

1. Close the Web browser window for your_name##-3.

2. Close the virtual machine consoles.

3. Remove the scheduling affinity value from your_name##-2.

a. Right-click the your_name##-2 virtual machine in the inventory and select Edit Settings.

b. Click the Virtual Hardware tab if its not selected.

c. Click the arrow next to CPU and delete the value 1 from the text box in the Scheduling 
Affinity pane.

d. Click OK.

4. Repeat step 3 on your_name##-3. 
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Lab 20
Using Alarms :

Objective: Demonstrate the vCenter Server alarm feature

In this lab, you will perform the following tasks:

1. Create a Virtual Machine Alarm That Monitors for a Condition

2. Create a Virtual Machine Alarm That Monitors for an Event

3. Trigger Virtual Machine Alarms and Acknowledge the Alarms

4. Disable Virtual Machine Alarms

Task 1: Create a Virtual Machine Alarm That Monitors for a Condition

Alarms are notifications that occur in response to selected events, conditions, and states that occur 
with objects in the inventory.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• VMware® vCenter™ Server Appliance™

• VMware® vCenter Server™ root password

1. If the VMware vSphere® Web Client is not already active, use it to log in to your team vCenter 
Server system.

2. Log in as user root, with the password.

3. Select Home > vCenter > Hosts and Clusters. 
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4. Select the your_name##-2 virtual machine in the inventory and select Manage > Alarm 
Definitions.

Note that the virtual machine inherited alarms defined at the vCenter Server level.

5. Click the Add icon in the Alarm Definitions pane. 

The Alarm Settings dialog box is displayed.

NOTE

Because you are creating an alarm for the your_name##-2 virtual machine, this alarm monitors 
only that virtual machine. If you set the alarm on an object higher in the vCenter Server 
inventory, the alarm applies to multiple virtual machines. For example, if you create the alarm 
on the vCenter Server object itself, the alarm applies to all virtual machines.

6. In the General tab, perform the following actions.

7. On the Triggers tab, click Add.

8. Perform the following actions to add a trigger.

Option Action

Alarm name Type VM CPU Usage - your_name.

Description Leave blank.

Alarm Type – Monitor Select Virtual Machine and select Monitor for specific 
conditions or state, for example, CPU usage.

Enable this alarm Leave selected.

Click Next.

Option Action

Trigger Select VM CPU Usage.

Operator Select Is above.

Warning Condition Double-click the current value and type 25.

Condition Length Select for 30 sec from the drop-down menu.
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9. Click Next.

10. Click the Add icon.

11. Configure the following action settings.

12. Click Finish. 

13. Verify that your alarm is in the list of alarms. 

Task 2: Create a Virtual Machine Alarm That Monitors for an Event

Creating an alarm involves setting up general alarm settings, alarm triggers, trigger reporting, and 
alarm actions.

1. Select Home > vCenter > Hosts and Clusters >Training in the inventory. 

2. Select Manage > Alarm Definitions. 

3. Click the Add icon. 

The Alarm Settings dialog box is displayed.

Critical Condition Type 50.

Condition Length Leave the default (5 minutes).

Option Action

Action Click Send a notification email below the Action header to activate 
the drop-down menu and select Suspend VM from the list.

Configuration Leave this field blank.

Green to Yellow Select Once from the list.

Yellow to Red Change the setting from Once to no value.

Red to Yellow Leave blank.

Yellow to Green Leave blank.

Option Action
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4. In the General tab, perform the following actions.

5. Click Next.

6. Click the Add icon.

7. Click the drop-down arrow in the Event column to select a drop-down menu with a list of 
triggers. Perform the following actions.

8. Below the Following Conditions column, click the Add icon. 

9. In the Argument column, select the drop-down menu labeled Change tag and select VM name 
from the list.

10. In the Operator column, leave equal to selected.

11. Click the area under the Value column. 

12. Type your_name##-2 as the virtual machine name. 

your_name is your first name, and ## is the number of your VMware ESXi™ host. The virtual 
machine name is case-sensitive.

13. Click Next.

14. Without making changes in the Actions tab, click Finish. 

15. Verify that your alarm is in the list of alarms. 

Option Action

Alarm name Type VM Suspended - your_name.

Description Leave blank.

Alarm Type – Monitor Select Virtual Machines and select Monitor for specific event 
occurring on this object, for example, VM Power On.

Enable this alarm Leave selected.

Option Action

Event Select VM suspended.

Status Keep the default.
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Task 3: Trigger Virtual Machine Alarms and Acknowledge the Alarms

After an alarm is acknowledged, its alarm actions are discontinued. Alarms are neither cleared nor 
reset when acknowledged.

Students should do the steps in this task individually.

1. Click the your_name##-2 virtual machine in the inventory and select Monitor > Issues. 

2. Click the Triggered Alarms button. 

Triggered alarms are displayed in this pane.

3. In the inventory, right-click the your_name##-2 virtual machine and select Open Console.

4. Position the virtual machine console so that you can see both the console and the Triggered 
Alarms pane at the same time.

5. On the virtual machine’s desktop, right-click cpubusy.vbs and select Open with Command 
Prompt. 

This action starts one instance of cpubusy.vbs. Wait at least 30 seconds before the alarm is 
triggered. When the virtual machine is suspended, the alarm has been triggered.

NOTE

Your VM CPU Usage alarm appears only briefly in the Triggered Alarms pane. So you might 
not see this alarm if you are not viewing the pane at the time the alarm was triggered. But you 
should see your VM Suspended alarm after the virtual machine is suspended.

6. Monitor the Recent Tasks pane for the Suspend Virtual Machine task.

7. Verify that your VM Suspended alarm is triggered. 

You should see an entry for this alarm in the Triggered Alarms pane. The Acknowledged and 
Acknowledged By text boxes are blank.

8. Right-click your VM Suspended alarm and select Reset to Green. 

The Acknowledged and Acknowledged By text boxes are now populated.

9. To power on the suspended virtual machine, right-click the virtual machine in the inventory and 
select Power On.

10. In the virtual machine console, press Ctrl+C in the command window to stop cpubusy.vbs.

11. Close the virtual machine console.

12. In the Alarms tab, right-click your VM Suspended alarm and select Clear. 

13. In the inventory, verify that the red alert icon is removed from the virtual machine.
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Task 4: Disable Virtual Machine Alarms

You disable alarms from the object on which they were defined. You can enable a disabled alarm at 
any time.

Students should do the steps in this task individually.

1. Disable your VM CPU Usage alarm.

a. Select the your_name##-2 virtual machine in the inventory.

b. Click the Manage tab and click the Alarms Definitions tab.

c. Right-click your VM CPU Usage alarm and select Edit.

d. In the General tab, deselect the Enable this alarm check box and click Finish.

2. Disable your VM Suspended alarm.

a. Select Home > vCenter > Hosts and Clusters.

b. Select the Training data center in the inventory.

c. Click the Manage tab and click the Alarms Definitions tab. 

d. Find your VM Suspended alarm in the list, right-click the alarm, and select Edit.

e. In the General tab, deselect the Enable this alarm check box and click Finish.

3. Leave the VMware vSphere® Web Client open for the next lab.



21

Lab 21 Using VMware vSphere High Availability 109

Lab 21
Using VMware vSphere High Availability :

Objective: Demonstrate vSphere HA functionality

In this lab, you will perform the following tasks:

1. Create a Cluster Enabled for vSphere HA

2. Add Your ESXi Host to a Cluster

3. Test vSphere HA Functionality

4. Determine the vSphere HA Cluster Resource Usage

5. Manage vSphere HA Slot Size

6. Configure a vSphere HA Cluster with Strict Admission Control

7. Prepare for Upcoming Labs

Task 1: Create a Cluster Enabled for vSphere HA

VMware vSphere® High Availability clusters enable a collection of VMware ESXi™ hosts to work 
together. A group of ESXi hosts can provide higher levels of availability for virtual machines than 
each ESXi host can provide individually.

Do this task as a team. Student A should do the steps in this task.
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Use the following information from the class configuration handout:

• VMware® vCenter™ Server Appliance™

• VMware® vCenter Server™ root password

1. If the VMware vSphere® Web Client is not already active, use it to log in to your team vCenter 
Server system. 

2. Log in as user root with the password that you recorded.

3. Select Home > vCenter > Hosts and Clusters.

4. In the inventory, right-click the Training datacenter and click New Cluster. 

5. When prompted by the New Cluster wizard, perform the following actions.

6. Click OK.

7. Monitor the Recent Tasks pane. 

A cluster is created. 

Option Action

Name Type Lab Cluster.

vSphere HA Click Turn on next to vSphere HA.

Host Monitoring Leave the default setting selected.

Admission Control Status Leave the default setting selected.

Policy Click Percentage of cluster resources reserved as 
failover spare capacity.

VM Monitoring Status Leave the default setting selected.

EVC Leave the default setting selected.

Virtual SAN Leave the default setting selected.
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Task 2: Add Your ESXi Host to a Cluster

After you have planned the resources and networking architecture of your cluster, you can use the 
vSphere Web Client to add hosts to the cluster and specify the cluster’s vSphere HA settings.

Students should do the steps in this task individually.

1. Select Home > vCenter > Hosts and Clusters.

2. Expand your Lab Servers folder inventory object and select your ESXi host.

3. Drag your ESXi host to the Lab Cluster inventory object.

Your existing resource pools will be collapsed into the cluster root resource pool.

4. Monitor the Recent Tasks pane and wait for the Configuring vSphere HA task to complete.

5. After vSphere HA is enabled, select the Lab Cluster inventory object.

6. Click the Monitor tab and click the vSphere HA tab. 

The vSphere HA Summary status pane is displayed. 

7. Review the content on each tab. 

Q1. Which host is the master host?

1. The answer depends on which host wins the election.

Q2. Does the number of protected virtual machines match the number of virtual 
machines in the cluster?

2. The number of virtual machines protected by vSphere HA varies from one team to another. 
The number depends on how many virtual machines the teams have created and how many of 
those virtual machines are powered on.

8. Click Heartbeat.

Q3. How many datastores are used for heartbeating?

3. Both shared datastores are shown in the heartbeat because both have live virtual machines.

9. Click the Configuration Issues link and review the errors that are listed.

NOTE

The errors indicate that the ESXi hosts in the cluster have no management network redundancy. 
That is, each ESXi host has a single management network port configured for the cluster. 
vSphere HA still works if an ESXi host is configured with one management network port, but a 
second management network port is necessary for redundancy.

10. Select your host in the inventory and navigate to Manage > Networking > VMKernel 
Adapters.



112 Lab 21 Using VMware vSphere High Availability

11. Select the vMotion VMkernel adapter.

12. Click the Edit Settings icon.

13. Enable the Management Traffic check box and click OK.

14. Right-click your ESXi host and select All vCenter Actions > Reconfigure for vSphere HA.

15. Select Lab Cluster.

Q4. Have the previous configuration errors disappeared?

4. Yes, the error message has disappeared. 

Task 3: Test vSphere HA Functionality

Verify that vSphere HA works properly.

Do this task as a team. Student B should do the steps in this task.

1. Select Home > vCenter > Hosts and Clusters.

2. In the inventory, select the master ESXi host.

3. Click the Related Objects tab and click the Virtual Machines tab. 

4. Record the name of one or more powered-on virtual machines on the master host. __________

5. Simulate a host failure by rebooting one of the hosts in the cluster.

CAUTION

Ensure that you reboot the system and that you do not shut down the system.

a. Right-click the master ESXi host that you recorded in task 2, step 7 Q1, and click Reboot.

A message warns you that your host is not in maintenance mode.

b. Type Testing vSphere HA as the reason for rebooting and click OK.

6. In the inventory, select Lab Cluster.
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7. Click the Monitor tab and click the Events tab.

The cluster entries are sorted by time. Note the entries that vSphere HA made when the host 
failure was detected.

NOTE

The initial messages from the hosts might indicate failures. These messages are indicative that 
the virtual machines on the downed host have failed. It will take 1 to 2 minutes for the virtual 
machines to successfully migrate to the new host.
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8. Select the running ESXi host in the cluster.

9. Click the Related Objects tab and click the Virtual Machines tab.

The virtual machines that were running on the original master ESXi host should now be running 
on the remaining host in the cluster.

10. Monitor the vCenter Server inventory until you see that the original master ESXi host is 
available. 

11. Click the Lab Cluster inventory object.

12. Click the Summary tab.

13. Select Monitor > vSphere HA.

14. Compare the results to the answer in task 2, step 7 Q1.

Q1. Has the master host changed?

1. Yes. The slave host should have been elected the master host.

Task 4: Determine the vSphere HA Cluster Resource Usage

Record the information found on the Resource Allocation tab for Lab Cluster and answer questions 
based on that information. 

Do this task as a cluster team. Student B should do the steps in this task.

1. Select Home > vCenter > Hosts and Clusters.

2. Select Lab Cluster in the inventory and click the Resource Allocation tab. 

Your view should look like the screenshot.
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3. Record the following information.

• CPU total capacity (GHz) for the cluster __________

• CPU reserved capacity (GHz) for the cluster __________

• CPU available capacity (GHz) for the cluster __________

• Virtual machine in the inventory that has the highest CPU requirement, the number of 
virtual CPUs (vCPUs), and CPU speed of the virtual machine __________

NOTE

One way to determine these values is to view each virtual machine’s Summary tab. View 
how many vCPUs the virtual machine has. Then view the Summary tab of the ESXi host 
on which your virtual machines are located. View the speed of the host’s CPU. The speed 
of the physical CPU determines the speed of the vCPU.

• Memory total capacity (GB) for the cluster __________

• Memory reserved capacity (GB) for the cluster __________

• Memory available capacity (GB) for the cluster __________

• Virtual machine that has the highest memory requirement and the memory size of the 
virtual machine __________

NOTE

One way to determine these values is to view each virtual machine’s Summary tab and 
verify the memory size of the virtual machine.

Task 5: Manage vSphere HA Slot Size

vCenter Server uses admission control to ensure that sufficient resources are available in a cluster to 
provide failover protection and to ensure that virtual machine resource reservations are respected.

Do this task as a cluster team. Student A should do the steps in this task.

1. Select Home > vCenter > Hosts and Clusters.

2. Right-click Lab Cluster in the inventory and select Settings.

3. Select vSphere HA and click Edit.

4. Click the arrow next to Admission Control to expand the Admission Control options.

5. Ensure that the Define failover capacity by static number of hosts policy is selected.

6. Click OK.

7. Select Lab Cluster in the inventory.
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8. Click the Monitor tab and click the vSphere HA tab.

9. View the slot information for this cluster.

a. In the Advanced Runtime Info, view the slot information for this cluster.

b. Record the CPU space and RAM that your default slot requires. __________

10. Select Home > vCenter > VMs and Templates.

11. Set the CPU reservation on the virtual machine your_name##-3.

a. Right-click your_name##-3 in the inventory and select Edit Settings.

b. Click the arrow to expand CPU properties. 

The CPU setting is selected.

c. Set the Reservation text box to 512MHz.

d. Click OK to commit the change.

12. Select Home > vCenter > Hosts and Clusters.

13. View slot information for this cluster.

a. In the Monitor > vSphere HA tab of the cluster, view the Advanced Runtime Info pane.

b. Record whether changing the reservation changed the slot size from the value that you 
recorded in step 9. __________

c. Record the CPU, vCPU space, and RAM that your slot requires now. __________

14. Use the vSphere HA Slot size policy to enforce a slot size.

a. Right-click Lab Cluster in the inventory and select Settings.

b. Click Edit.

c. Expand the Admission Control options.

d. Select Fixed slot size.

e. In CPU slot size, type 300.

f. Next to VMs requiring multiple slots, click the Calculate button. 

Because the CPU slot size has now been fixed to 300MHz, the virtual machine yourname-3 
with its 512MHz CPU reservation will use two slots while powering on. Click the View 
link to verify the virtual machines that require multiple slots.

g. Click OK to close the Edit Cluster Settings window.
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15. View the slot information for this cluster.

a. Click the Monitor tab and click the vSphere HA tab of the cluster. 

b. View the Advanced Runtime Info pane. Compare the current value with what you recorded 
in step 13.

Q1. What are the CPU, vCPU space, and RAM that your slot requires?

1. The slot size CPU value should now show 300MHz.

16. Remove the vSphere HA fixed slot size setting.

a. Right-click Lab Cluster in the inventory and select Settings.

b. Click Edit.

c. Expand the Admission Control options.

d. Select Cover all powered-on virtual machines.

e. Click OK to close the Edit Cluster Settings window.

17. Remove the CPU reservation on your_name##-3.

a. Right-click your_name##-3 in the inventory and select Edit Settings.

b. Click the arrow to expand CPU properties. 

c. Change the CPU reservation to 0 (MHz).

d. Click OK to commit the change.

Task 6: Configure a vSphere HA Cluster with Strict Admission Control

A slot is a logical representation of memory and CPU resources. By default, it is sized to satisfy the 
requirements, that is, the reservations, for any powered-on virtual machine in the cluster.

Do this task as a cluster team. Student B should do the steps in this task.

NOTE

In task 5, when you configured your cluster with Define failover capacity by static number of 
hosts, you instructed vSphere HA to calculate slots. vSphere HA calculated the space for a virtual 
machine to run based on the largest CPU and memory reservation across all virtual machines. In this 
task, you learn how strict admission control works.

1. Select Home > vCenter > Hosts and Clusters > Lab Cluster > Related Objects > Virtual 
Machines. 

2. Shut down all virtual machines.

3. After all virtual machines are powered off, click the Lab Cluster > Summary tab.
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4. Identify the total memory capacity and divide it by the number of ESXi hosts in the cluster. 

The result is the usable memory per ESXi host. For example, if you have two ESXi hosts in 
your cluster and the total capacity for memory is 8GB, then 8 / 2 = 4. 

NOTE

The value for Total Capacity that you see in this step might differ from what you see in the 
screenshot.

5. Record the available memory per ESXi host. __________

The virtual machines have no memory reservations.

Q1. Why is less memory available in the cluster than in the total memory installed 
in the ESXi hosts?

1. Less memory is available because of the overhead needed to run the VMkernel. The 
VMkernel is holding back memory for its own use.

6. Click the Monitor tab for the Lab Cluster and click the Resource Allocation button.

7. Click Memory.

8. Identify the Total Capacity, Reserved Capacity, and Available Capacity for your Lab Cluster.

Q2. Why is the available capacity less than the amount that was calculated in step 
5?

2. The available capacity is less because the cluster is configured to tolerate the loss of one of 
the two hosts, and there is overhead to run the ESXi host.
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9. Assign a 384MB memory reservation to each your_name-##-2 virtual machine.

a. Right-click each your_name##-2 virtual machine listed in the Resource Allocation tab and 
select All vCenter Actions > Edit Resource Settings.

b. Set the memory reservation to 384 MB.

c. Click OK to commit the changes.

10. Before powering on virtual machines, select Lab Cluster.

11. Click the Monitor tab and the vSphere HA tab.

12. Record the total number of slots in the cluster. __________

Q3. Why does the vSphere Web Client report that many slots?

3. The vSphere Web Client reports N/A for the total number of slots because no virtual machines 
have been powered on yet. The slot size calculation considers only virtual machines that are 
powered on.

13. Right-click the student_A_name##-2 virtual machine and select Power On.

14. To see the effect that powering on this virtual machine has on your cluster, click Refresh to 
refresh the Advanced Runtime Info pane.

Q4. What are the values that you see for total slots, used slots, available slots, and 
failover slots?

4. You should see six total slots (three per host in the cluster): one used slot, two available slots, 
and three failover slots.

Q5. Why is the value for Failover slots only half the number of Total slots?

5. The value is half the number of Total slots because you must reserve half of the slots to be 
able to tolerate the failure of one host in the cluster.

15. Record the values that you see.

• CPU slot size (MHz) __________

• Memory slot size (MB) __________

Q6. Why does the memory slot size not match the value that you recorded?

6. Unlike the CPU slot size calculation, which is based solely on the largest CPU reservation, 
the calculation for memory slot size is based on the largest memory reservation, plus memory 
overhead.

16. In the inventory, right-click each of your student_A_name##-3 virtual machines and select 
Power On.
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17. Click Refresh to refresh the Advanced Runtime Info pane and view the number of available 
slots change.

Q7. How many slots are available now and what is the reason?

7. Zero slots are available because the cluster only has six slots. Of those slots, only three slots 
were originally available because you had to reserve three failover slots. You have now used all 
the available slots.

18. Right-click the student_B_name##-2 virtual machine and select Power > Power On.

19. Monitor the Recent tasks pane.

Q8. Is your virtual machine allowed to power on and what is the reason?

8. The virtual machine was not allowed to power on because the cluster has no available slots. 

Q9. If a cluster has N total slots, does it mean that you can power on N virtual 
machines?

9. No. Of those N total slots, some will be failover slots. The number of virtual machines that you 
can run is necessarily less than the number of slots. For example, in a two-host cluster that 
tolerates the failure of one host, only N/2 slots are available.

Task 7: Prepare for Upcoming Labs

Remove the Lab Servers folder, which is no longer needed. Then reconfigure the cluster for 
upcoming labs by removing the memory reservations that were set up previously and by disabling 
admission control.

Do this task as a cluster team. Student A should do the steps in this task.

1. Right-click the Lab Servers folder inventory object and select All vCenter Actions > 
Remove from Inventory.

2. Click Yes to confirm the operation.

3. In the inventory, select Lab Cluster and click Monitor > Resource Allocation.

4. Click Memory and remove the virtual machine memory reservation for each of the virtual 
machines.

a. Right-click each virtual machine that has a memory reservation and click All vCenter 
Actions > Edit Resource Settings.

b. Select the memory reservation value (for example, 384) and type 0.

c. Click OK.

d. Repeat steps a through c for the other virtual machines with reservations.
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5. Edit the settings of the cluster to allow the number of running virtual machines to exceed the 
failover capacity of the cluster.

a. In the inventory, right-click Lab Cluster and select Settings.

b. In the right pane, select vSphere HA.

c. Click Edit.

d. Expand Admission Control and select Do not reserve failover capacity.

e. Click OK to commit your changes.

6. Keep the vSphere Web Client open for the next lab.
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Lab 22
(Optional) Designing a Network 
Configuration :

Objective: Design a network configuration for an ESXi 
host, based on a set of requirements

In this lab, you will perform the following tasks:

1. Analyze the Requirements

2. Design Virtual Switches and Physical Connections

Based on a scenario, you design the network configuration for a VMware ESXi™ host, specifying 
the following requirements:

• Virtual switches

• Ports and port groups

• Port group policies

• Physical connections

A set of network requirements is provided. The requirements are not complete and they leave a good 
deal of detail to the imagination. Use your assumptions to complete those details (stating your 
assumptions when appropriate).

This lab can be done separately by each member in the ESXi team.

Task 1: Analyze the Requirements

In this task, you analyze the requirements for a network configuration for an ESXI host.
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You are the administrator in charge of configuring an ESXi host in your company’s production 
environment. This ESXi host is one of several hosts that must be configured identically in your 
production environment. 

Plan for configuring the ESXi host so that it can be one node in a VMware vSphere® Distributed 
Resource Scheduler™ or VMware vSphere® High Availability cluster. 

Do not configure the cluster at this time, but have all the necessary networking details in place so 
that the cluster can be configured later.

1. Use the following networking requirements to inform your analysis of the configuration.

2. Add details to the requirements in the table.

Component Networking Requirements

Virtual machines and 
applications

Web-based applications that are implemented by using four virtual 
machines arranged as follows:

• VM1 and VM2: Web servers, and network address translation (NAT) 
clients of VM3

• VM3: front end for the Web servers. Acts as a NAT router for the back-
end virtual machines

• VM4: a test box, used to test intrusion detection systems and virus-
protection software, among other applications.

An intrusion detection system (IDS) is a device or application that 
monitors a network for malicious activities or policy violations and 
produces reports to a management system.

IP-based storage A NAS, used to hold running virtual machines for the test virtual machines 
only (storage for the production virtual machines is provided by a SAN)

Physical NICs Four physical network adapters: one 1 GigE and three 10 GigE

External networks Two physical switches and four external LANs, each named to indicate its 
purpose. A single physical switch is configured to handle traffic for three 
networks, which are implemented as VLANs. One physical switch is 
dedicated to the management LAN, which, by company policy, must be 
physically separate from all other networks. The management LAN is used 
by VMware® vCenter Server™ for monitoring vSphere HA heartbeat, 
among other uses.
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Task 2: Design Virtual Switches and Physical Connections

In this task, you use the information in task 1 and the diagram to draw a network configuration. 

No single answer is correct. In fact, many reasonable solutions are possible. The point of this lab is 
not to find the single correct answer. Rather, this lab encourages a discussion of the advantages and 
disadvantages of different solutions.

• Using the information in task 1 and the following diagram, draw a network configuration. 

• Show all virtual switches, their ports, and their port groups. 

• Indicate the policies to be applied to each [switch, port, and port group?] (NIC teaming, 
VLANs, security, traffic shaping). 

• Show the connections from the virtual machines to the virtual switches.

• Show the connections from the physical NICs to the physical switches.
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Lab 23
Configuring VMware vSphere Fault 
Tolerance :

Objective: Configure vSphere FT for a virtual machine 
and verify that vSphere FT works

In this lab, you will perform the following tasks:

1. Prepare the Virtual Machine

2. Enable the vSphere FT Logging

3. Activate the vSphere FT Protection

4. Test the vSphere FT Configuration

5. Disable and Turn Off vSphere FT Protection

NOTE

Not all classroom lab environments support VMware vSphere® Fault Tolerance. If the hardware in 
your classroom does not support vSphere FT, do the exercise with the vSphere FT simulation 
provided by your instructor. Adobe Flash Player 8 or later is required to view the simulation.
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Task 1: Prepare the Virtual Machine

Configure a virtual machine capable of using vSphere FT in a nested VMware ESXi™ environment 
(that is, running ESXi hosts as virtual machines).

Students should perform this lab as a team. Student A should do the steps in this task. Do this task 
only if your instructor tells you to do it.

Use the following information from the class configuration handout:

• VMware® vCenter™ Server Appliance™

• VMware® vCenter Server™ root password

• Partner ESXi host

CAUTION

Nested ESXi is not an officially supported configuration, nor is running vSphere FT in nested ESXi. 
Neither configuration should be used in production environments. 

This task should be performed only by students using a nested lab environment. For example, the 
vClass environment provided by VMware® uses a nested environment, which requires additional 
steps to be performed to enable the lab to work. If you are unsure whether you should do this task, 
ask your instructor. 

1. If the VMware vSphere® Web Client is not already active, log in to the team vCenter Server 
system as user root, with the password that you recorded.

2. Select Home > vCenter > VMs and Templates.

3. Select one of the your_name##-# virtual machines, where ## corresponds to the number of your 
ESXi host. 

4. Record the name of the virtual machine. __________

5. If the virtual machine is powered on, shut down the guest operating system.

6. Right-click the virtual machine and select Edit Settings. 

7. Click CD/DVD drive 1 and verify that the Client Device is selected in the drop-down menu 
next to CD/DVD drive 1.

8. Expand the CD/DVD drive 1 properties and verify that Passthrough CDROM is selected in 
the Device Mode drop-down menu.

9. Click the VM Options tab and click the arrow next to Advanced.

10. Click Edit Configuration next to Configuration Parameters.

11. In the Name column, find the replay.supported line. 
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12. In the Value column, change false to true and press Enter.

13. Add the replay.allowFT and replay.allowBTOnly lines to the Configuration 
Parameters.

a. On the Configuration Parameters page, click Add Row.

b. In the Name column, type replay.allowFT. 

c. In the Value column, type true.

d. In the Name column, type replay.allowBTOnly. 

e. In the Value column, type true.

The Configuration Parameters page should look like the screenshot.

14. Click OK twice. 

Wait for the virtual machine to do a reconfiguration. 

15. After the configuration is complete, leave the vSphere Web Client open.
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Task 2: Enable the vSphere FT Logging

On each host that you want to add to a VMware vSphere® High Availability cluster, you must 
configure two VMkernel ports. This configuration ensures that the host can also support vSphere FT.

NOTE

This lab uses only a single VMkernel port for fault-tolerant traffic and shares the VMkernel port 
with the vMotion VMkernel interface that you configured in an earlier lab. In most environments, 
you would use a separate VMkernel port for each feature.

Students should do the steps in this task individually.

1. Select Home > vCenter > Hosts and Clusters. 

2. Select your ESXi host in the inventory and click the Summary tab. 

3. View the Configuration pane. 

The Host Configured for FT field should show No.

4. Click the Manage tab.

5. Click the Networking link and click VMkernel adapters.

6. Select vMotion from the list and click the Edit Settings icon.

7. Select the Fault Tolerance Logging check box and click OK. 

8. Click the Summary tab and confirm that the Host Configured for FT field now shows Yes.

CAUTION

If this lab is performed in a nested ESXi environment, this text box continues to show No 
because ESXi is installed on virtual hardware, not physical hardware.

9. Wait for your ESXi host partner to complete this task.

Task 3: Activate the vSphere FT Protection

After you have finished all the required steps for enabling vSphere FT for your cluster, you can use 
the feature by turning it on for individual virtual machines.

Student B should do the steps in this task.

1. If the vSphere Web Client is not already active, use the vSphere Web Client to log in to the 
team vCenter Server system as user root.

2. Select Home > vCenter > Hosts and Clusters. 
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3. Select the virtual machine you recorded in Task 1, step 3, in the inventory and verify that it 
meets the requirements for vSphere FT, as outlined in the lecture book.

CAUTION

If this lab is performed in a nested ESXi environment, you must select the virtual machine that 
was configured in task 1.

4. If the virtual machine is powered on, right-click the virtual machine and select Shut Down 
Guest OS. 

5. Click Yes to confirm shutdown.

6. Right-click the virtual machine and select All vCenter Actions > Fault Tolerance > Turn On 
Fault Tolerance.

7. Read the warning and click Yes to confirm to activate vSphere FT.

8. Monitor the Recent Tasks pane while vSphere HA is turning on vSphere FT. 

The virtual machine icon will change to a dark blue color when the Fault Tolerance 
configuration is complete.

9. After the tasks complete, view the information in the Summary tab of the virtual machine.

a. Find the Host value at the top of the tab and record the host on which the primary virtual 
machine is located. __________

b. Find the value Secondary Location in the Fault Tolerance pane of the Summary tab and 
record the host on which the secondary virtual machine is located. __________

10. Power on the virtual machine and observe how the information in the Fault Tolerance panel on 
the virtual machine Summary pane changes.

Task 4: Test the vSphere FT Configuration

Test the vSphere FT configuration.

Student A should do the steps in this task.

1. Open a console to the primary virtual machine.

2. Open the VMware® vSphere Client™ and connect directly to the ESXi host that you recorded 
in task 3, step 9b.

3. In the inventory, right-click the secondary virtual machine name and click Open Console. 

The virtual machine is labeled your_name##-# (Secondary).

4. Arrange the consoles side by side. 

5. Log in to the primary virtual machine as Administrator.
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6. In the primary virtual machine, open a Command Prompt window and type ipconfig.

7. Record the IP address of the primary virtual machine. __________

8. Start a continuous ping to your ESXi host:

# ping -t <ESXi_host_name>

9. Return to the vSphere Web Client. In the inventory, right-click your virtual machine and select 
All vCenter Actions > Fault Tolerance > Test Failover to simulate a virtual machine failure.

10. Quickly view the virtual machine consoles side by side and watch what happens over the next 
couple of minutes. Monitor particularly the console title bars.

The virtual machine console in the vSphere Web Client still shows the primary’s console, but 
the primary is now running on the other host. The vSphere Client continues to display the 
console of the virtual machine running on the host to which you connected, but now it is the 
primary virtual machine. Both open console windows are displaying the primary.

11. Record whether the ping operation increased in its time value during the failover. __________

12. Click the your_name##-# Summary tab in the vSphere Web Client.

13. View the host information displayed for the primary and the secondary virtual machines. 

14. Access the console of the primary virtual machine. 

15. Press Ctrl+C to stop the continuous pings. 

16. Close the consoles.

17. Close the vSphere Client but leave the vSphere Web Client open.

Task 5: Disable and Turn Off vSphere FT Protection

Disabling vSphere FT for a virtual machine suspends its fault tolerance protection by halting the 
secondary virtual machine but preserving it and its configuration and history.

Student B should do the steps in this task.

1. In the vSphere Web Client inventory, right-click the protected virtual machine and select All 
vCenter Actions > Fault Tolerance and view the menu options.
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2. Compare the warning messages that you would see if you were turning off vSphere FT instead 
of disabling vSphere FT.

a. Click Turn Off Fault Tolerance. 

A warning message is displayed. 

b. Read the warning message and note which actions are taken. 

c. Click No. 

d. Right-click the protected virtual machine and select Fault Tolerance. 

e. Select Disable Fault Tolerance. 

f. Read the warning message and note which actions are taken. 

g. Click No.

Q1. What is the difference between Turn Off Fault Tolerance and Disable Fault 
Tolerance?

1. Turning off vSphere FT removes vSphere FT protection from this virtual machine and deletes 
all historical vSphere FT data. Disabling vSphere FT removes vSphere FT protection from this 
virtual machine but keeps historical information about vSphere FT performance.

h. Right-click the protected virtual machine and select Fault Tolerance > Turn Off Fault 
Tolerance. 

i. When the warning message is displayed, click Yes. 

3. Verify that the Fault Tolerance pane on the Summary tab is no longer present.

4. Click Home > vCenter > Hosts and Clusters > Lab Cluster.

5. Click Monitor > Resource Allocation > Memory.

6. Verify that the your_name##-# virtual machine does not have a memory reservation configured.

a. If the virtual machine still has a reservation configured, right-click the virtual machine and 
click All vCenter Actions > Edit Resource Settings.

b. Change Memory Reservation to 0.

c. Click OK.

7. Leave the vSphere Web Client open for the next lab.
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Lab 24
VMware vSphere Distributed Resource 
Scheduler :

Objective: Implement a DRS cluster

In this lab, you will perform the following tasks:

1. Create a Load Imbalance

2. Create a DRS Cluster

3. Verify Proper DRS Cluster Functionality

4. Create, Test, and Disable a VM-VM Affinity Rule

5. Create, Test, and Disable an Anti-Affinity Rule

6. Create, Test, and Disable a Virtual Machines to Hosts Affinity Rule



136 Lab 24 VMware vSphere Distributed Resource Scheduler

Task 1: Create a Load Imbalance

Create a load imbalance across the hosts.

Student A should do the steps in this task.

Use the following information from the class configuration handout:

• VMware® vCenter™ Server Appliance™

• VMware® vCenter Server™ root password

1. If the VMware vSphere® Web Client is not already active, log in to the team vCenter Server 
system as user root with the password that you recorded.

2. Migrate all the virtual machines to one host. 

3. Select Home > vCenter > Hosts and Clusters.

4. In the inventory, select Lab Cluster and click the Related Objects > Virtual Machines tab.

5. Right-click each virtual machine and select Power On. 

Wait for all virtual machines to power on.

Four virtual machines should be running on the same host. If all virtual machines are not 
running on the same host, migrate the virtual machines by using VMware vSphere® vMotion®.

6. Start an instance of cpubusy.vbs in three or four of the powered-on virtual machines.

a. Right-click a virtual machine and select Open Console.

b. Log in to your virtual machine as Administrator, with the password that you recorded.

c. To start an instance of the cpubusy.vbs script (on the virtual machine’s desktop), right-
click the script and select Open with Command Prompt.

7. Repeat steps 6 a through c until you have three or four virtual machines running CPU busy.

NOTE

The number of virtual machines running cpubusy.vbs necessary to cause VMware vSphere® 
Distributed Resource Scheduler™ (DRS) to begin migrations depends on the resource capacity 
of the lab infrastructure. Your instructor can advise you on how many virtual machines running 
cpubusy.vbs you need.
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Task 2: Create a DRS Cluster

A DRS cluster is a collection of VMware ESXi™ hosts and associated virtual machines with shared 
resources and a shared management interface.

Student B should do the steps in this task.

1. If the vSphere Web Client is not already active, log in to the team vCenter Server system as user 
root.

2. Select Home > vCenter > Hosts and Clusters.

3. Right-click the Lab Cluster inventory object and select Settings.

a. Select vSphere DRS and click Edit.

b. Select the Turn on vSphere DRS check box.

c. Next to DRS Automation, select Manual from the drop-down menu.

d. Click the arrow next to DRS Automation and move the Migration Threshold slider to the 
right to Aggressive.

e. Click OK to apply the changes.

Task 3: Verify Proper DRS Cluster Functionality

Verify that the DRS cluster is functioning properly. 

Student A should do the steps in this task.

1. Select Home > vCenter > Hosts and Clusters.

2. Click the Lab Cluster inventory object.

3. Click Monitor.

4. Click the vSphere DRS tab.

5. Click the Run DRS Now button. 

Clicking this link forces DRS to immediately evaluate the cluster and provide recommendations 
instead of waiting the standard 5 minutes before generating recommendations.

6. Click the Summary tab.

7. Observe the vSphere DRS panel on the Summary tab.

Q1. Does the gauge show that the load is imbalanced?

1. Yes, because all the virtual machines are running on a single host.

8. Select Monitor > vSphere DRS > CPU Utilization.
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9. View the Sum of Virtual Machine CPU Utilization - Per Host chart.

10. Select the Show as % drop-down menu and select MHz.

This chart displays the CPU use per host. Point to each colored square. You see information on 
how much of the entitled resource each virtual machine is using.

11. Click Recommendations.

12. Review the DRS recommendations.

13. Click Apply Recommendations and monitor the Recent Tasks pane for virtual machine 
migrations. 

Wait for the virtual machine migrations to complete.

14. Click the Run DRS Now button in the upper-left corner of the DRS tab. 

This action forces DRS to evaluate the cluster status.

15. Click the Summary tab.

Q2. Does the gauge show that the load is balanced?

2. It depends on your lab environment. Even it the cluster is still imbalanced, it is more balanced 
than it was and DRS has improved the resource allocation for the virtual machines.

16. Select Monitor > vSphere DRS > CPU Utilization.

17. Wait about one minute and press the Refresh button in the vSphere Web Client. 

The virtual machines should spread across the two hosts.

18. To stop the cpubusy.vbs scripts in each virtual machine, press Ctrl+C in each cpubusy 
window.

19. Close the virtual machine consoles.

Task 4: Create, Test, and Disable a VM-VM Affinity Rule

A VM-VM affinity rule specifies whether the selected individual virtual machines should run on the 
same host or be kept on separate hosts.

Students should do the steps in this task individually.

1. Select Lab Cluster in the inventory.

2. Click the Related Objects tab and click the Virtual Machines tab. 
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3. Verify that the two virtual machines that you own are running on different ESXi hosts. 

If the virtual machines that you own are running on the same ESXi host, select one to migrate to 
the other ESXi host in the cluster before you go to step 4. If you have one virtual machine on 
each ESXi host in the cluster, no action is necessary.

NOTE

If you do not see the Host text box in the table, right-click one of the gray column names. Select 
Show/Hide Columns and select Host from the list.

4. Right-click Lab Cluster in the inventory and select Settings. 

5. Select DRS Rules and click Add.

The Lab Cluster Settings dialog box is displayed.

6. Perform the following actions in the Lab Cluster Settings dialog box. 

a. In the Name text box, type Colocate your_first_name VMs.

b. From the Type drop-down menu, select Keep Virtual Machines Together.

c. Click Add to add members.

d. In the Virtual Machines dialog box, select the check box next to each of the virtual 
machines that you own, named your_name##-#.

e. Click OK.

7. Click OK to close the Create DRS Rule dialog box.

8. Select Monitor > vSphere DRS > Recommendations.

9. Evaluate the cluster configuration by clicking the Run DRS Now link. 

Q1. Do you see any recommendations and what is the reason?

1. Yes, because the DRS affinity rule that you created is trying to keep the virtual machines 
together on the same host.

NOTE

If you did not get a recommendation, use vSphere vMotion migration to move one of your 
named virtual machines to the other ESXi host in the cluster. Return to the DRS tab and click 
Run DRS to see what the results are. 

10. If you are ahead of your lab partner, wait for your partner to reach this point in the lab.
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11. Student A should click Apply Recommendations and monitor the Recent Tasks pane as the 
recommendation is applied. 

The virtual machines associated with your affinity rule are migrated to one of the two hosts in 
the DRS cluster. 

12. Click the Related Objects tab and click the Virtual Machines tab. 

13. Click the Host column heading to sort the virtual machines by the ESXi host on which they 
reside. 

The virtual machines that you own should be running on the same ESXi host.

14. Right-click the Lab Cluster inventory object and select Settings.

15. Select DRS Rules, select your affinity rule, and click Edit.

16. To disable the affinity rule, deselect the Enable rule check box next to your affinity rule and 
click OK.

Task 5: Create, Test, and Disable an Anti-Affinity Rule

With an anti-affinity rule, DRS ensures that the specified virtual machines are kept on separate 
hosts.

Students should do the steps in this task individually.

1. Right-click Lab Cluster in the inventory and select Settings. 

2. Click DRS Rules.

3. On the DRS Rules page, click Add.

4. Perform the following actions in the Rules dialog box. 

a. In the Name text box, type Separate your_first_name VMs.

b. From the Type drop-down menu, select Separate Virtual Machines.

c. Click Add.

d. In the Virtual Machines dialog box, select the check box next to each of the virtual 
machines that you own, named your_name##-#.

e. Click OK.

5. In the Rules dialog box, click OK.

6. Select Lab Cluster.

7. Click the Monitor tab and click the vSphere DRS tab. 
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8. Click the Run DRS Now button to make DRS evaluate the state of the cluster and make 
recommendations. 

A recommendation to separate your virtual machines should be displayed. The recommendation 
is a priority 1 as a result of the DRS rules. If a recommendation is not displayed, check the rules 
that you created to verify the accuracy of your inputs.

9. If you are ahead of your lab partner, wait for your partner to reach this point in the lab.

10. Student B should click Apply Recommendations.

11. Monitor the Recent Tasks pane as the recommendations are applied. 

The virtual machines with anti-affinity rules applied to them are migrated to another ESXi host 
in the cluster.

12. Click the Related Objects tab and click the Virtual Machines tab.

13. Click the Host column heading to sort the virtual machines by the ESXi host on which they 
reside. 

The virtual machines you own should be running on different ESXi hosts.

14. Right-click the Lab Cluster inventory object and select Settings.

15. In the left pane, select DRS Rules and click the rule you just created.

16. Click Delete.

17. Click Yes to delete the DRS rule.

Task 6: Create, Test, and Disable a Virtual Machines to Hosts Affinity 
Rule

A Virtual Machines to Hosts affinity rule specifies whether the members of a selected virtual 
machine DRS group can run on the members of a specific host DRS group.

Students should do the steps in this task individually.

1. Right-click Lab Cluster in the vCenter Server inventory and select Settings.

2. In the left pane, select DRS Groups.

3. In the DRS Groups panel, click Add.

4. In the DRS Group window, perform the following steps.

a. In the Name text box, type your_name-VMs.

b. From the Type drop-down menu, ensure that VM DRS Group is selected.

c. Click Add.
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d. Click both of your named virtual machines to select them.

e. Click OK.

f. Click OK.

5. In the DRS Groups panel, click Add.

6. In the DRS Group window, perform the following steps.

a. In the Name text box, type your_name-ESXi host.

b. Change the type to Host DRS Group.

c. Click Add.

d. Click the ESXi host assigned to you to select it.

e. Click OK.

f. Click OK.

7. In the left pane, click DRS Rules.

8. Click Add.

9. In the Rules dialog box, perform the following actions.

10. Click OK to close the Rules dialog box.

11. Select Lab Cluster.

12. Click the Monitor tab and click the vSphere DRS tab. 

13. Click the Run DRS link to make DRS evaluate the state of the cluster and make 
recommendations. 

If no recommendations are made, the virtual machine might already be located on the correct 
host. You might need to migrate the virtual machine to the other ESXi host.

Option Action

Name Type Run only on your_name-ESXi host.

Type Select Virtual Machines to Hosts from the drop-down menu.

Cluster VM Group Select your_name-VMs from the drop-down menu.

Select Must run on hosts in group from the drop-down menu.

Cluster Host Group Select your_name-ESXi host from the drop-down menu.
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14. Record why DRS has made this recommendation. __________

15. If you are ahead of your lab partner, wait for your partner to reach this point in the lab.

16. Student A should click Apply Recommendations.

17. Monitor the Recent Tasks pane as the recommendations are applied. 

The virtual machines with Virtual Machines to Hosts affinity rules applied to them are migrated 
to another ESXi host in the cluster.

18. Click the Related Objects tab and click the Virtual Machines tab.

19. Click the Host column heading to sort the virtual machines by the ESXi host on which they 
reside. 

The virtual machines that you own that were running on your partner’s ESXi host should have 
been migrated to your ESXi host.

20. Right-click one of your virtual machines and click Migrate.

21. In the Migrate Virtual Machine wizard, perform the following actions.

Q1. What do you see in the Compatibility panel?

1. You receive the error message: “Virtual machine 'your_name##-#' on host 'host_name' would 
violate a Virtual Machines to Hosts affinity rule.”

22. Click Cancel to close the Migrate Virtual Machine wizard.

23. Right-click the Lab Cluster inventory object and select Settings.

24. In the left pane, select DRS Rules.

25. To disable your Virtual Machines to Hosts affinity rule, select the rule, click Edit, and deselect 
Enable rule.

26. Click OK.

27. Leave your vSphere Web Client open for the next lab.

Option Action

Select Migration Type Select Change host. Click Next.

Select Destination Resource Select Lab Cluster and select the Allow host selecting 
within this cluster check box.
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Lab 25
VMware vSphere Update Manager :

Objective: Install, configure, and use vSphere Update 
Manager

In this lab, you will perform the following tasks:

1. Install vSphere Update Manager

2. Install the Update Manager Client Plug-In

3. Modify Cluster Settings

4. Configure vSphere Update Manager

5. Create a Patch Baseline

6. Attach a Baseline and Scan for Updates

7. Stage the Patches onto the ESXi Hosts

8. Remediate the ESXi Hosts

Task 1: Install vSphere Update Manager

If your VMware® vCenter Server™ system is running on Windows, you can install the VMware 
vSphere® Update Manager™ server component either on the same computer as the vCenter Server 
system or on another computer. If you are using the VMware® vCenter™ Server Appliance™, the 
vSphere Update Manager server component must be installed elsewhere.

Do this task as a team. Student A should perform this task.
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Use the following information from the class configuration handout:

• vSphere Update Manager system name

• Location of installation software

• Setup language

• vCenter Server system name

• vCenter Server root password

1. If you are not already connected to the desktop that you recorded for installing vSphere Update 
Manager, open a connection to it now.

This action is typically done with Remote Desktop Connection. Your instructor will provide 
specific details if you are to use some other technology.

2. Go to the location of the installation software.

3. Double-click autorun.exe.

4. If security warning dialog boxes are displayed, click Run. 

5. In the VMware vCenter Installer window, click the vSphere Update Manager link.

6. Click Install to start the installation wizard.

7. Click Run when the Security Warning dialog box is displayed.

8. When prompted by the installation wizard, perform the following actions.

 

Option Action

Setup Language Select the setup language that you recorded and click OK.

Welcome page Click Next.

License Agreement Select I accept the terms in the license agreement and 
click Next.

Support Information Deselect Download updates from default sources 
immediately after installation and click Next.

IP Address/Name Type the team vCenter Server system name or IP address.

Port Accept the default.

Username Type root.
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9. Click Finish to close the installation wizard.

10. Click Exit to close the VMware vCenter Installer window.

Task 2: Install the Update Manager Client Plug-In

To use vSphere Update Manager, you must install the Update Manager Client plug-in, which is 
delivered as a plug-in for the VMware vSphere® Client™.

Students should do the steps in this task individually.

Use the following information from the class configuration handout:

• vCenter Server root password

1. Open the vSphere Client and log in to your team vCenter Server system as user root. Use the 
password that you recorded.

2. In the menu bar, select Plug-ins > Manage Plug-ins.

3. Under Available Plug-ins in the Plug-in Manager window, click the Download and Install link 
next to VMware vSphere Update Manager Extension.

4. If security warning dialog boxes are displayed, click Run.

Password Type the root password that you recorded. Click Next.

Database Options Accept the default and click Next.

VMware vSphere Update 
Manager Port Settings

If name resolution is working, select the host name from the 
drop-down menu. If name resolution is not working, select 
the IP address from the drop-down menu.

Accept the default selection for all other settings and click 
Next.

Destination Folder Accept the default selection for all other settings and click 
Next.

Click OK when the warning box is displayed.

Ready to Install the Program Click Install.

Option Action
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5. When prompted by the VMware vSphere Update Manager Client 5.5 wizard, perform the 
following actions. 

6. When the installation completes, click Finish.

7. When the security warning is displayed, select Install this certificate and do not display any 
security warnings for “host_name” to prevent this warning from being displayed in the future.

8. Click Ignore to proceed with the connection.

9. Verify in the Plug-in Manager window that the Update Manager Client plug-in was enabled.

10. Click Close to close the Plug-in Manager window.

11. Leave the vSphere Client open.

Task 3: Modify Cluster Settings

Enable VMware vSphere® Distributed Resource Scheduler™ (DRS) in fully automated mode and 
disable VMware vSphere® High Availability admission control.

Students should work as a team to complete this task. Student B should perform this task.

1. Select Home > Inventory > Hosts and Clusters.

2. Right-click Lab Cluster in the inventory and select Edit Settings. 

The Lab Cluster Settings dialog box is displayed.

3. In the left pane, select vSphere DRS. 

4. Select Fully Automated. 

This operation enables vSphere DRS to migrate virtual machines as necessary without asking 
permission from an administrator.

5. In the left pane, select vSphere HA. 

Option Action

Setup Language Select the setup language that you recorded. Click OK.

Welcome page Click Next.

License Agreement Select I accept the terms in the license agreement and 
click Next.

Ready to Install the Program Click Install.
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6. Click Disable: Allow VM power on operations that violate availability constraints in the 
Admission Control page. 

7. Click OK.

8. Select Lab Cluster in the inventory and click the Resource Allocation tab.

9. Observe the Reservations column to verify that no CPU and memory reservations are assigned 
to virtual machines. 

Removing CPU and memory reservations is necessary for this training environment. In a 
production environment, you might not have to remove CPU or memory reservations.

Task 4: Configure vSphere Update Manager

Instead of using a shared repository or the Internet as a download source for patches and extensions, 
you can import patches and extensions manually by using an offline bundle.

Do this task as a team. Student A should perform this task.

Use the following information from the class configuration handout:

• VMware ESXi™ patch bundle

1. Select Home > Solutions and Applications > Update Manager.

2. Click the Configuration tab.

3. Click the Download Settings link.

4. Click the Import Patches link.

5. Click Browse and select the ESXi patch bundle that you recorded. 

6. Click Open.

7. Click Next.

8. When the security warning is displayed, select Install this certificate and do not display any 
security warnings for “host_name” to prevent this warning from being displayed in the future.

9. Click Ignore to proceed with the connection.

10. Click Finish to complete the import operation.
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Task 5: Create a Patch Baseline

Baselines contain a collection of one or more patches, extensions, or upgrades.

Do this task as a team. Student B should perform this task.

1. Click the Baselines and Groups tab. 

You see two Create links: one under the Baseline panel and one under the Baseline Groups panel.

2. Click the Create link under the Baseline panel.

3. When prompted by the New Baseline wizard, perform the following actions.

Task 6: Attach a Baseline and Scan for Updates

Scanning is the process in which attributes of a set of hosts, virtual machines, or virtual appliances 
are evaluated against the patches, extensions, and upgrades included in the attached baselines and 
baseline groups.

Do this task as a team. Student A should perform this task.

1. In the upper-right corner of the Baselines and Groups tab, click the Compliance View link. 

2. Select Lab Cluster in the vCenter Server inventory and click the Update Manager tab.

If you do not see the Update Manager tab, click the right arrow to access it.

3. Click the Attach link. 

The Attach Baseline or Group dialog box is displayed.

Option Action

Baseline Name Type ESXi Host Update.

Baseline Description Type Patch for ESXi 5.5.

Baseline Type Keep the default value and click Next.

Patch Options Select Fixed and click Next.

Patches Select each patch and click the down arrow under the horizontal 
scroll bar to add the patch to the Fixed Patches to Add pane.

Click Next.

Ready to Complete Review your patch baseline. Verify the accuracy of Baseline 
Name and Baseline Type and click Finish.
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4. Select the ESXi Host Update check box and click Attach.

5. Click the Scan link. 

6. In the Confirm Scan window, verify that the Patches and Extensions and Upgrades check 
boxes are selected.

7. Click Scan.

8. Monitor the Recent Tasks pane and wait for the scan to finish. 

When the task is complete, the scan should discover that the ESXi hosts are noncompliant.

Task 7: Stage the Patches onto the ESXi Hosts

Staging patches and extensions speeds up the remediation process because the patches and 
extensions are already available locally on the hosts.

Students should do the steps in this task individually.

1. Select your ESXi host from the right pane of the Update Manager tab in the lab cluster.

You should see both ESXi hosts on the Update Manager tab of the lab cluster. Do not select 
the ESXi hosts from the vCenter Server inventory in the left pane.

2. Click Stage.

3. When prompted by the Stage wizard, perform the following actions.

4. Monitor the Recent Tasks pane for the staging tasks. 

Wait for the tasks to complete.

NOTE

Both team members must complete task 7 before proceeding to task 8.

Option Action

Baseline Selection Accept the default selections and click Next.

In the Patches column, you see that zero patches are staged.

Patch and Extension 
Exclusion

Accept the default selections and click Next.

Ready to Complete Click Finish.



152 Lab 25 VMware vSphere Update Manager

Task 8: Remediate the ESXi Hosts

Remediation of hosts in a cluster requires that you temporarily disable cluster features such as 
VMware vSphere® Distributed Power Managment™ and VMware vSphere® HA admission 
control.

Do this task as a team. Student B should perform this task.

1. In the vCenter Server inventory, select Lab Cluster.

2. Click the Update Manager tab.

3. To begin the patching process, click Remediate.

4. When prompted by the Remediate wizard, perform the following actions.

Option Action

Remediation Selection Leave the default and click Next.

Patches and Extensions Leave the default and click Next.

Schedule Leave the default and click Next.

Host Remediation Options Select Disable any removeable media devices connected 
to the virtual machines on the host.

Leave all other fields at their default selection and click 
Next.

Cluster Remediation Options Deselect Disable Distributed Power Management 
(DPM) if it is enabled for any of the selected clusters.

Click Generate Report to identify which tasks the 
remediation process performs for you.

Click Close and click Next.

Ready to Complete Review and verify your selections for accuracy. Click 
Finish.
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5. Monitor the Recent Tasks pane.

The hosts in Lab Cluster show 100 percent compliance when remediation completes.

Q1. Which ESXi host was remediated first?

1. Answers vary.

Q2. Was the ESXi host placed into maintenance mode by the remediation process? 

2. Yes

Q3. Were the virtual machines migrated to the other node in the cluster?

3. All powered-on virtual machines were migrated. Any powered-off virtual machine was not 
migrated.

Q4. Was the patch installed on the ESXi host in maintenance mode?

4. Yes

Q5. Was the patched ESXi host rebooted?

5. Yes

Q6. Did the patched ESXi host exit maintenance mode?

6. Yes

Q7. Was the other node placed into maintenance mode?

7. Yes

Q8. Were the virtual machines that the ESXi host migrated to the other node 
present in the cluster?

8. Yes

Q9. Was the other ESXi host patched?

9. Yes

Q10. Did the other node exit the maintenance mode?

10. Yes
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Lab 26
(Optional) Installing the VMware vCenter 
Server Components :

Objective: Install the vCenter Server components

In this lab, you will perform the following tasks:

1. Install the vCenter Server Components

Task 1: Install the vCenter Server Components

Install the VMware® vCenter Server™ software.

Students should do the steps in this task as a team.

Use the following information from the class configuration handout:

• Windows vCenter Server system name

• vCenter Server administrator password

• Location of the vCenter Server installation software

1. Browse to the location of the vCenter Server installation software.

2. Start the VMware vCenter Installer.

• If you have an ISO image or physical CD-ROM mounted on the vCenter Server system’s 
CD-ROM drive and autorun is enabled, the installer main window is displayed.

• For files that are located in a local folder or that are on a network share, open the folder 
containing the files and double-click the autorun.exe file. 
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3. If security warning messages are displayed, click Run to continue.

4. Click the vCenter Server Simple Install link and click Install. 

5. If a security warning message is displayed, click Run to continue.

6. When prompted by the installation wizard, perform the following actions.

Option Action

Welcome Page Click Next.

License Agreement Select I agree to the terms in the license agreement and 
click Next. You do not assign a license for this lab.

Simple Install Prerequisites Click Next.

Single Sign On Information In the Password and Confirm Password text boxes, type 
the password that you recorded.

Site name Type Training-Site and click Next.

Simple Install Port Settings Accept the default option and click Next.

Destination Folder Accept the default folder and click Next.

Simple Install Information Click the Install button. Wait for the VMware® vCenter™ 
Single Sign-On™ installation to complete and the VMware 
vSphere® Web Client installation starts, followed by the 
Inventory Service installation and the vCenter Server 
installation.

License Key Do not type a license key. Install in evaluation mode and 
click Next.

Database Options Select Install a Microsoft SQL Server 2008 Express 
instance and click Next.

vCenter Server Service Select Use Local SYSTEM Account. Verify that the 
default fully qualified domain name (FQDN) matches your 
local system name, which you recorded. If the values do 
not match, change the FQDN to the correct value. Click 
Next.

Configure Ports Accept the default and click Next.
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7. When the installation is complete, click Finish to exit the wizard. 

8. Click OK in the VMware vCenter Installer dialog box.

9. Close the VMware vCenter Installer window.

vCenter Server JVM Memory Accept the default and click Next.

Ready to Install the Program Click Install.

Option Action
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Answer Key

Lab 3: Working with Virtual Machines

Task 3: Identify a Virtual Machine Disk Format and Usage Statistics . . . . . . . . . . . . . . . . .14
1. The disk type should read Thin Provision.

Lab 6: Configuring VMware vCenter Single Sign-On

Task 2: Use the vSphere Web Client to Add the Domain Admins 
Group to Administrators  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .32
1. You do not see any hosts in the inventory. 

Although you have permission to log in to the 
server, you have not given permissions to the 
VMware ESXi™ administrators to see any of 
the vCenter Server objects in the inventory.

Lab 7: Creating Folders in VMware vCenter Server

Task 2: Create Two Virtual Machine Folders  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .36
1. The Lab Servers folder displays menu 

choices related to host actions whereas the 
LabVM and Templates folders display 
menu choices related to virtual machines.

Lab 13: Modifying a Virtual Machine

Task 1: Increase the Size of a VMDK File. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .59
1. For example, if you are using a vClass kit, this 

value is approximately 2GB.
2. The value should differ by ~1GB.

Lab 15: Managing Virtual Machines

Task 1: Unregister a Virtual Machine in the vCenter Server Inventory . . . . . . . . . . . . . . . .75
1. Yes, there is a folder named your_name##-4. 

When the virtual machine was first created, it 
and its folder were named Hot-Clone##. 
When the virtual machine was renamed to 

your_name##-4, its folder's name was not 
renamed. Only when the virtual machine was 
migrated to a new datastore was the folder 
automatically renamed to your_name##-4.
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Task 5: Revert to a Snapshot . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .81
1. Yes. Because the memory state was not 

preserved.

2. No.

3. No. Because the memory state was 
preserved.

4. Yes.

5. No.

Task 6: Delete an Individual Snapshot . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .82
1. No. 2. Yes.

Task 7: Use the Delete All Function in Snapshot Manager. . . . . . . . . . . . . . . . . . . . . . . . .82
1. Yes.

2. Yes. The current state of the virtual machine 
was not altered. All that happened was that 

snapshots were removed. There is no longer 
an option to revert to those earlier points in 
time.

Lab 16: Managing VMware vSphere vApps

Task 1: Create a vApp. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .85
1. You see the vApp, but not the virtual 

machines themselves.
2. Yes. You can see the vApp and the virtual 

machines that the vApp contains.

Task 2: Power on a vApp  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .87
1. No. The first virtual machine powers on and 

about 20 seconds later, the second virtual 
machine powers on.

Lab 17: User Permissions

Task 3: Verify Permission Usability . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .92
1. Only the LabVMs folder, their ESXi host, your 

datastore, and the ProdVMs network were 
available.

Lab 18: Resource Pools

Task 4: Verify Resource Pool Functionality. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .98
1. 2,000

2. 8,000

3. The Fin-Test resource pool (and thus the 
virtual machine in it) has only one-fourth of the 
CPU shares that the Fin-Prod resource pool 
has. So the virtual machine in the Fin-Test 

resource pool receives only one-fourth of the 
CPU cycles of the logical CPU to which the 
virtual machines are pinned. Note: In the past, 
bugs have required that the virtual machines 
be powered off before being dragged to the 
resource pool.

Lab 19: Monitoring Virtual Machine Performance

Task 2: Use vSphere Web Client to Monitor CPU Utilization  . . . . . . . . . . . . . . . . . . . . . .100
1. Yes. The CPU ready value should decrease 

significantly because the CPU contention that 
was created by running the cpubusy.vbs 
script was terminated.
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Lab 21: Using VMware vSphere High Availability

Task 2: Add Your ESXi Host to a Cluster . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .111
1. The answer depends on which host wins the 

election.

2. The number of virtual machines protected by 
vSphere HA varies from one team to another. 
The number depends on how many virtual 
machines the teams have created and how 
many of those virtual machines are powered 
on.

3. Both shared datastores are shown in the 
heartbeat because both have live virtual 
machines.

4. Yes, the error message has disappeared.

Task 3: Test vSphere HA Functionality . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .112
1. Yes. The slave host should have been elected 

the master host.

Task 5: Manage vSphere HA Slot Size . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .115
1. The slot size CPU value should now show 

300MHz.

Task 6: Configure a vSphere HA Cluster with Strict Admission Control . . . . . . . . . . . . . .117
1. Less memory is available because of the 

overhead needed to run the VMkernel. The 
VMkernel is holding back memory for its own 
use.

2. The available capacity is less because the 
cluster is configured to tolerate the loss of one 
of the two hosts, and there is overhead to run 
the ESXi host.

3. The vSphere Web Client reports N/A for the 
total number of slots because no virtual 
machines have been powered on yet. The slot 
size calculation considers only virtual 
machines that are powered on.

4. You should see six total slots (three per host 
in the cluster): one used slot, two available 
slots, and three failover slots.

5. The value is half the number of Total slots 
because you must reserve half of the slots to 
be able to tolerate the failure of one host in the 
cluster.

6. Unlike the CPU slot size calculation, which is 
based solely on the largest CPU reservation, 
the calculation for memory slot size is based 
on the largest memory reservation, plus 
memory overhead.

7. Zero slots are available because the cluster 
only has six slots. Of those slots, only three 
slots were originally available because you 
had to reserve three failover slots. You have 
now used all the available slots.

8. The virtual machine was not allowed to power 
on because the cluster has no available slots.

9. No. Of those N total slots, some will be failover 
slots. The number of virtual machines that you 
can run is necessarily less than the number of 
slots. For example, in a two-host cluster that 
tolerates the failure of one host, only N/2 slots 
are available.

Lab 23: Configuring VMware vSphere Fault Tolerance

Task 5: Disable and Turn Off vSphere FT Protection . . . . . . . . . . . . . . . . . . . . . . . . . . . .132
1. Turning off vSphere FT removes vSphere FT 

protection from this virtual machine and 
deletes all historical vSphere FT data. 
Disabling vSphere FT removes vSphere FT 
protection from this virtual machine but keeps 

historical information about vSphere FT 
performance.
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Lab 24: VMware vSphere Distributed Resource Scheduler

Task 3: Verify Proper DRS Cluster Functionality  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .137
1. Yes, because all the virtual machines are 

running on a single host.

2. It depends on your lab environment. Even it 
the cluster is still imbalanced, it is more 

balanced than it was and DRS has improved 
the resource allocation for the virtual 
machines.

Task 4: Create, Test, and Disable a VM-VM Affinity Rule. . . . . . . . . . . . . . . . . . . . . . . . .138
1. Yes, because the DRS affinity rule that you 

created is trying to keep the virtual machines 
together on the same host.

Task 6: Create, Test, and Disable a Virtual Machines to Hosts Affinity Rule . . . . . . . . . .141
1. You receive the error message: “Virtual 

machine 'your_name##-#' on host 
'host_name' would violate a Virtual Machines 
to Hosts affinity rule.”

Lab 25: VMware vSphere Update Manager

Task 8: Remediate the ESXi Hosts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .152
1. Answers vary.

2. Yes

3. All powered-on virtual machines were 
migrated. Any powered-off virtual machine 
was not migrated.

4. Yes

5. Yes

6. Yes

7. Yes

8. Yes

9. Yes

10. Yes


